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Copyright

Cyberbank assumes no responsibility for any damage or loss resulting form the
use of this manual. And also Cyberbank assumes no responsibility for any
damage or loss caused by deletion of data as a result of malfunction, dead
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media to protect against data loss.

The information contained in this document is provided “as is” and is subject to change
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incidental or consequential damages in connection with the furnishing, performance, or
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are reserved. No part of this document may be photocopied, reproduced, adapted, or
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as allowed under the copyright laws.
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service marks, trademarks, or registered trademarks of their respective owners.
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FCC RF Exposure Information

In August 1996 the Federal Communications Commission (FCC) of the United States with its action in
Report and Order FCC 96-326 adopted an updated safety standard for human exposure to radio
frequency electromagnetic energy emitted by FCC regulated transmitters. Those guidelines are consistent
with the safety standard previously set by both U.S. and international standards bodies. The design of POZ
complies with the FCC guidelines and these international standards.

Use only the supplied or an approved antenna. Unauthorized antennas, modifications, or attachments
could impair call quality, damage your POZ, or result in violation of FCC regulations.

Do not use your POZ with a damaged antenna.  If a damaged antenna comes into contact with the skin, a
minor burn may result. Please contact your local dealer for replacement antenna.

To comply with FCC RF exposure requirements, the testing was performed to measure
worst case SAR with Ocm separation to the body phantom with no clip/holster. The use
of third-party belt-clips / holsters with no metallic components that provide the minimum
separation distance of 1inch (2.54cm) can be used to satisfy FCC RF exposure
requirements. The use of accessories that contain metallic components may not
comply with FCC RF exposure requirements and should be avoided. Contact

your local dealer for optional accessory items.

For more information about RF exposure, please visit the FCC website at www.fcc.qov

Specific Absorption Rate (SAR) for Wireless Phones

The SAR is a value that corresponds to the relative amount of RF energy absorbed in the
head of a user for a wireless handset. The SAR value of a phone is the result of an
extensive testing, measuring and calculation process. It does not represent how much
RF the phone emits. All phone models are tested at their highest value in strict laboratory
settings. But when in operation, the SAR of a phone can be substantially less that the
level reported to the FCC. This is because of a variety of factors including its proximity to
a base station antenna, phone design and other factors. What is important to remember
is that each phone meets strict federal guidelines. Variations in SARs do not represent a
variation in safety. All phones must meet the federal standard, which incorporates a
substantial margin of safety. As stated above, variations in SAR values between different
model phones do not mean variations in safety. SAR values at or below the federal
standard of 1.6W/kg are considered safe for use by the public.

The highest reported SAR values of CB-0870 are:

CDMA mode (Part 22)- Head: 1.47 W/kg; Body-worn: 1.27 W/kg

FCC Radio Frequency Emission

This phone meets the FCC Radio Frequency Emission Guidelines. FCC ID number:
PGVCB-0870. More information on the phone’'s SAR can be found from the following
FCC website: http://www.fcc.gov/oet/fceid



Safety Information

Please read these simple guidelines before using your phone. Failure to comply with these guidelines may
be dangerous or illegal.

Do not use a hand held phone whilst driving a vehicle; park the vehicle first.

Switch off your phone when in an aircraft. The use of cellular phones whilst airborne is illegal in some
countries. It may disrupt the operation of the aircraft. Follow any regulations or rules regarding air travel.

Wireless phones can cause interference. Switch off your phone near medical equipment.

Do not use your mobile phone at a petrol station or near fuel, chemicals or in any area where blasting is in
progress. Observe restrictions and follow all rules and regulations.

Use the phone only in a normal manner as instructed in this manual and do not handle the antenna
unnecessarily.

Only qualified service personnel must install or repair equipment. Breaking the warranty seal and opening
the casing of the phone will void your warranty.

Use only approved accessories and batteries. Do not connect to incompatible products.

Avoid any contact with water and any type of moisture.
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Chapter 1
About Device

Congratulations on purchasing PDA (personal digital assistant) device powered by
Microsoft® Windows® for Pocket PC. Your device lets you keep your most important
business and personal information current and close at hand. Your device includes
Microsoft Pocket PC Software 2002, which includes the latest version of Microsoft
Pocket Outlook®, so you can read and write e-mail while on the road and manage your
appointments and contacts. You will find that your device is also the perfect companion
to your desktop or notebook PC, allowing you to take vital business data and documents
with you and easily upload updated information. The device offers you the highest quality
in performance and power management as well as rich programs and utilities designed
by cyberbank.

@ In this chapter, you will find:
- What's in the Box?

- Hardware Features

- Using Stylus

- Soft Reset & Hard Reset

- Microsoft Pocket PC Software
- The 3™ programs

- Where to Find Information

- Using This Manual
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What’s in the Box?

Your device package includes the following items:

Device Cradle & USB Cable AC Adapter

Quick Start Gide Users Manual  (inCiides Microsot

(A . graphic gwdg to ActiveSync® and Microsoft
setting up your device.) Outlook 2002 for your desktop
PC, as well as programs and
utilities that add functionality to
your device.)

User’s Manual | 1-2



Hardware Features

The illustrations below introduces you to the various buttons and other features of your
device.

Stylus: Use the stylus to navigate on the touch screen.

Stereo headphone jack: Connect a proprietary stereo headphone.
SD (Secure Digital) card slot: Insert an optional SD card to add memory.
Up/down control button: Scroll through documents.

® o 6 T o

Infrared port: Beam files to other mobile devices.
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Battery: main battery(1400mAh).

Antenna: used for built-in cellular module.

Phone status LED: flashes when a phone-call comes in and displays the status of
mobile phone. Notifies you of phone status including SMS.

Speaker: Listen to music or set audible reminders and alerts and hear the voice
while communicating on the mobile phone.

Touch screen(TFT LCD): Tap on-screen controls or buttons to select menu
commands or input text.

Charging status LED: indicates power status while recharging. (Blue : fully charged,
Red : charging)

Hot keys: Press to open an application or programmed function.

Microphone: Speak into the microphone to record voice notes and communicate on
the mobile phone.

Navigation pad: Press to navigate through documents or select on-screen buttons
and controls.

Power button: Press to turn your device on and off.

Phone button: Press to turn your phone program on.

Enter button: Press it once to have the last called phone number displayed on the
phone display with the phone program on and press it once to finish your
communication you want.

Reset button: Use the stylus to press the reset button and restart your device so that
all your unsaved files will be deleted.

USB port: Connect to your desktop PC using the supplied cradle, or directly through
an optional sync cable.
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Using the Stylus

Use the stylus to navigate and select objects on the screen.

Tap
Touch the screen once with the stylus to open items and select options.

Drag
Hold the stylus on the screen and drag across the screen to select text and
images. Drag in a list to select multiple items.

Tap and hold
Tap and hold the stylus on an item to see a list of actions available for that item.
On the pop-up menu that appears, tap the action you want to perform.

Pop-up menu

With pop-up menus, you can quickly choose an action for an item. For example, you can
use the pop-up menu in the contact list to quickly delete a contact, make a copy of a
contact, or send an e-mail message to a contact. The actions in the pop-up menus vary
from program to program.

To access a pop-up menu, tap and hold the stylus on the name of the item that you want.
When the menu appears, lift the stylus, and tap the action you want. Or tap anywhere
outside the menu to close the menu without performing an action.

Create Copy )
Delete
Sselect All

Send yia E-mail... e Tap and hold to display the pop-up menu.

Beam File...

_ Lift the stylus and tap the action you want.
Rename,Move... © Select from the pop-up menu to copy,
delete, paste, select all, rename, move.

Mew Tools = E|*
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Soft Reset & Hard Reset

When your device is running slow or improperly, use the stylus to press the Reset button
located on the bottom. This is called “Soft Reset” in this manual. When you perform a
Soft Reset, you will lose all unsaved data. Be sure to save all data in open documents or
programs beforehand. This is similar to pressing the Reset button on your desktop.

Performing Hard Reset is at the same time to press the power button and the Enter
button located on the right side of your device. When you perform Hard Reset, you will
lose all information that is stored in the RAM. Be sure to save all data using ActiveSync
or the Backup utility before you perform Hard Reset.

Power button

Enter button

User’s Manual | 1-6



Microsoft Pocket PC Software

Your device already includes the full suite of software you need to function as a mobile
professional. These programs are introduced below.

Detailed information can be found in later chapters.

The programs listed below are preinstalled in Flash ROM or in the Built-in Flash. These
preinstalled programs will not be deleted if your device suffers a loss of power.

@ ActiveSync. Synchronize information between your device and desktop computer.
= calendar. Keep track of your appointments and create meeting requests.

Tasks. Keep track of your to-do list.

[=] contacts. Keep track of your friends and colleagues.

Notes. Create handwritten or typed notes, drawings, and recordings.

& Inbox. Send and receive e-mail messages from your device.

Pocket Word. Create new documents or view and edit Word documents created on
your desktop PC.

Pocket Excel. Create new workbooks or view and edit Excel workbooks created on
your desktop PC.

@ Microsoft Pocket Internet Explorer. Browse the Web and view channels and
subscription content.

B msN Messenger.! Send and receive instant messages with your MSN® Messenger
contacts.

& Microsoft Windows Media Player for Pocket PC.? Play audio and video clips on

your device. Windows Media™ Player lets you play songs and video files that have
been recorded in the MP3 or WMA formats.

1 Requires an account with an Internet service provider.
2 Check the Microsoft Mobile Devices Web site for updates to Windows Media Player, including details on
support for video file formats and streaming audio and video capabilities.
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The 3" Party Software

The Pocket PC Companion CD included with your device has additional programs for
both your desktop PC and your device. The programs listed below are preinstalled in
Flash ROM or Companion CD.

Phone. Enables you to make voice calls just like a mobile phone.

SMS(Short Message Service). Enables you to send and receive short messages to and
from other mobile phones.

Pocket Backup. Enables you to backup and restore the data in your device’s RAM to
and from SD cards and Built-in Flash.

Task Manager. Enables you to do the functions similar to the Task Manager on your
desktop PC.

ClearVue Presentation. Enables you to open Microsoft PowerPoint programs on your
device.

ClearVue Image. Enables you to view any image files on your device.
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Where to Find Information

ActiveSync

The ActiveSync Troubleshooter on your desktop PC is on the ActiveSync File menu,
click Connection Settings, and then click Help. You can install ActiveSync 3.6 from the
provided Companion CD. In case that you lose the companion CD, download and install
the latest ActiveSync 3.6 on www.microsoft.com/mobile/pocketpc/download on your

desktop PC and also download and install CyberbankUsBupdate.exe on www.cb.co.kr.
The reason is that ActiveSync 3.6 on companion CD has been updated with USB ID, but
the downloaded ActiveSync 3.6 on www.microsoft.com/mobile/pocketpc/download is not
updated with USB ID.

Using Help on Your Device
You can get help for specific programs and for Microsoft Pocket PC software by tapping
Help on the Start menu. Help can be displayed for the active program. To display a
menu of all Help files available on your device, tap the View menu, and then tap All
Installed Help, or simply tap Help while the Today screen is active.

Using This Manual

This User's manual is designed to help you get started using your device quickly and
easily. Although great care has been taken to ensure the accuracy of procedures and
artwork, some of the screens displayed on your device may be a little different from the
ones that appear in this User's manual.

This User's manual includes certain visual cues that will help you find the information you
want easily.

Notes : Helpful information related to the topic.

Notice : This is important information that should be observed to prevent loss of
data or damage to your device.
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Chapter 2
Getting Started

This chapter will help you start using your device. You will become familiar with the hardware
and learn how to set up your device. When you finish this chapter, you will have all the
information you need to begin working with your device.

(® This chapter includes step-by-step instructions to help you.
- Complete the Welcome Wizard

- Using Today Screen

- Using File Explorer

- Power up the first time

- Hardware buttons

- Caring for your device
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Complete the Welcome wizard

Follow the steps in this section to start using your device for the first time or after performing

hard-reset.

@11996 - 2002 Microsoft Corparation, All rights
resetwed, This computer program is protected
by LIS, and international copyright laws,

Tap the target firmly and accurately
at each location on the screen, The
target will continue to move until
the screen is aligned.

Gently touch the screen with stylus. From
now on, it is called “tap”.

A target (+) will move in the order of “center
— upper left —» lower left — lower right —
upper right” on your screen. Since

I

calibrating the touch screen has a direct
affect on the recognition ability of your touch
screen, be sure to accurately tap the center
of the target (+) with your stylus.
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You can use your stylus two ways:
* Single-tap
* Tap and hold

Buy stamps
O * Call Andy
[ ] Reschedule dental apot

Select all

When you tap and hold an itern
with your stylus, a pop-up menu
containing a list of actions appears,

[ Next |

se pop-up menus to reschedule
the following appointrment:

Tap and hold the 9 &M, dental
appointrnent, and then tap Cut on
the pop-up menu,

8

Y

9 v, Johnson's office
10 JC0ental appointment
11
12
1
2

| This is the way of how to single-tap and tap and
hold, tap the Next button.

Tap and hold this location to have next window.
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se pop-up menus to reschedule
the folowing appointrment:

Tap and hold the 9 &.M, dental
appointrnent, and then tap Cut on
the pop-up menu,

se pop-up menus to reschedule
the folowing appointrment:

MHowe tap and hold 11 &M, and
then tap Paste on the pop-up
MMEemnL,

B
9
10

11 ®
12

1

2

It is called “Pop-up” menu. Select Cut.

Tap and hold this location next to 11 to paste the
cut contents. Then you will have the new pop-up

menu.
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se pop-up menus to reschedule
the folowing appointrment:

MHowe tap and hold 11 &M, and
then tap Paste on the pop-up
MMEemnL,

Paste ¢
Delete

Congratulations! vYou have
rescheduled the appointment wsing
pop-Up menLUs,

8
9

10

11 IDr. Johnson's office
12 J0ental appointment
1
2

[Roer]

Select Paste on this list.

The pasted contents have appeared. Tap the Next

button.
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location

Select your time zone:

Setup is complete, Tap the screen
to begin using your device,

Time zone: |GP-'1T-B Pacific LIS ‘l‘i Select GMT-3 Brasilia from the drop-down list box.

Tap the screen to finish the Welcome wizard.
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Using Today Screen

After finishing the Welcome wizard, put your device on the cradle connected to your desktop
PC to automatically synchronize through Microsoft ActiveSync so that you have the next screen.

Start menu

Tx 4% 12:14

@ Monday, September 03, 2001
El Tap here to set owner infarmaktion

Enter your personal information which is not synchronized
Mo upconing appointrments with your desktop PC.

Synchronize today with your desktop PC through
ActiveSync

Now, you are ready to enter Owner information. Tap Owner information to have next screen.

#iF |settings Tx 4% 12:24 (D

Owner Information

Mame:

Campany':

Address:

Telephone:

E-mail:

Select this option box to have your personal
information displayed whenever you turn on
your device.

|:| Show information whene—— 34—
device is turned on

Identificakion | Motes |

E|‘

Tap any text box where you want to enter information to have input panel displayed. For more
detailed information on input panel, see chapter 3.
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£33 |settings Tx 4% 12:34 (D

Owner Information

Mame:

Campany':

Address:

Telephone:

E-mail:

Identification | Maokes
123/1(2]3]4]|5]6|7[8[0]0]- =]«
Tabla|wle[r[t[y[ufifo[p|[
caP[a[s[d[f]a[h]i[k[1]:]"
shift| z [x [c[v[b[n[m[, . |
ctilai] " [v] [4]1t

For more personal information if needed, select the Notes tab.

3 |settings Tx 4% 12:29 (D

Owner Information

Maokes:

D Shaows infFormation when. Select to have owner information displayed
device is turned on whenever turn on device.

IdentiFi-:atiu:un|Nu:utes|
123)1|2]3]4]|s5]6|7[8[0|0]-[=|w
Tabja[wle|r[t[y|uli[o[p|[]]
CaPla[sd[fla[n]ifk[1]:]"]
shift[z [x [c[v[b[n[m].
ctlaia] " [y ] |

—
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Status Icons

When the Today screen is displayed, you may see the following status icons on the Command
bar or Navigation bar. In most cases, you can tap a status icon to display the associated control
panel or more information related to the item. For example, tap a battery status icon to open
the Power control panel.

Icon Meaning

:E Speaker is on

E Speaker is off

EH Backup Battery is low

[ —] .

A Battery is low

! Battery is very low

¥ Battery is charging

¥ Battery is fully charged

H Synchronization is occurring
@] Synchronization is beginning or ending
B Internet connected

E Internet disconnected

Alerts and Notifications

Your device reminds you in a variety of ways when you have something to do. For example, if
you have set up an appointment in Calendar, a task with a due date in Tasks, or an alarm in
Clock, you will be notified in any of the following ways:

* A message appears on the screen.

* A sound, which you can specify, is played.

To choose reminder types and sounds for your device, tap Settings on the Start menu. On the
Personal tab, tap Sounds & Notifications.
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When you turn on your device for the first time each day (or after 4 hours of inactivity), you will
see the Today screen. You can also display it by tapping Today. On the Today screen, you can
see at glance important information for the day.

Select the Start menu to Display the current
switch to other programs. state of connection

Tx o= 12:14

Synchronize today with your desktop PC
Monday, September 03, 2001°* | through ActiveSync.

I Enter your personal information which is not
synchronized with your desktop PC.

E Tap here to set owner information

Mo upcoming Sppoin

Calendar, Inbox and tasks have been
synchronized with desktop PC.

Command Bar

® To start or switch programs

1. Press the Start menu.
2. Select the icon that corresponds to the program or document.

Tap to quickly Tap to change volume or mute the
select a program device.
you have — er 03, 2001
recently used. % Today bt inFormation

@l ActiveSync prenk: i

Tap to select a program.

Tap Settings to customize the device.
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The Navigation bar is located at the top of the screen. It displays the active program and
current time, and allows you to switch programs and close screens.

Use the Command bar at the bottom of the screen to perform tasks in programs. The
Command bar includes menu names, buttons, and the Input panel button. To create a new
item in the current program, tap New.

To open a program you have recently used, select the corresponding program icon.

You can customize both the New menu and the Start menu to make it easier to
access the programs you use frequently. On the Start menu, select Settings >
the Personal tab > Menu and select the icons you want as described.

You can switch programs using task manager.
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File Explorer

This File Explorer of your device is similar to Window Explorer of desktop PC.
Select the Start menu > Programs > File Explorer.

l.ﬂ?‘:.‘;rj" File Explorer Tx =% 1:45 9

My Device Mame - Select to go to the higher
level of a folder.

File Store  o—

1My Documents Select a folder below My Device you want to

= Program Files move to.

CiTemp o

1 Windows

mdmlogs 9,/3/01 54B

MobilePhone-...  9/3/01 OB

MobilePhone-...  9/3/01 OB

MobilePhone-..  9/3/01 OB

Edit Dpen|4 LIFE] E|A

® View the contents of SD(Secure Digital) card
Insert SD cards into the SD card slot so that SDMMC Disk folder appears. Tap this folder to
view the contents of SD card.

l.ﬂ?‘:.‘;rj" File Explorer Tx ={% 1:50 9

My Device - Mame -

File Store
1My Documents
= Program Files

Ch Temp

1 Windows

mdmlogs 9,/3/01 54B

MobilePhone-...  9/3/01 OB

MobilePhone-...  9/3/01 OB

MobilePhone-..  9/3/01 OB

SDMMC Disk o SD card folder

S — SD card folder icon

Edit Dpen|4 [!] e | E|‘
|

My Device icon
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® Pop-Up Menus

Tap and hold the file you cut, copy, rename and delete to have Pop-up menu displayed. Also tap

and hold out of files or folders to

have a little different pop-up menu that includes new folder. Now

we show you an example of process where we copy a file from a folder and paste it to another folder.

.Ej‘ File Explorer Tx £

My Documents -

2:29 €9

Mame -

[ChBusiness

ChPersonal

31 Templates

[Ef 05 9,/3,/01

Copy

DS Tap and hold a file you copy to have Pop-up

menu displayed and tap Copy.

Rename
Delete

Send via E-mail...
Beam File...

%et as Today Wallpaper o

Tap Set as Today Wallpaper to have this
file displayed as Today Wallpaper.

Edit open |~ (]| M &2

E|A

Tap and hold a file you copy to

have Pop-up menu displayed and tap Copy. Select Personal

you want to paste the copied file to. On the Personal folder, tap and hold the empty space to

have pop-up menu that includes Paste.

l.ﬂ?‘:.‘;rj" File Explorer Tx =% Z:41 9
Personal -

Mame -

Refresh
Yiew All Files

Paste
Paste shortcut
Mew Folder

Edit Dpen|4 LIFE]

E|‘
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Here are two different pop-up menus.

lﬁ;}.‘ File Explorer Ty 4% 2:29 9 &}‘i".ﬁ‘ File Explorer T 4% 2:43 9
My Documents « MName - My Documents MName -
[C1 Business [Cs1 Business
=1 Personal 1 Personal
) Templates ) Templates
[#f 05 9/3/01 _13.6K (B 05 [ pofreeh 1 19.6K
710 | viewalFiles P! 598K
— [H 11 D1 19.4K
[#f12 | Paste D1 88.6K
Rename Paste Shortcut
[ ]
Delete Mew Folder
Send via E-mail...
Beam File... °
Set as Today Wallpaper
Edit Dpen |4 LIFE] E|A Edit Dpen |4 LIFE E|A

This is pop-up menu that results from
tapping and hold a file.

This is pop-up menu that results from tap
and hold the empty space.
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® View All Files
Select View All Files on pop-up menu that results from tapping and hold the empty space to
view all files below My Device/My Documents/Templates.

l.ﬂ?‘:.‘;rj" File Explorer Tx ={% 4:09 9

Templates Mame
#Blank Docum...  9/3/01 OB
[_IBlank Note 9/3,/01 OB
MEEI:ing Motes 9,/3/01 1.86K
Meeting Motes 9/3/01 1.55K
& Memo 9/3/01 Z.06K
l,_|Memo 9/3/01 2.06K
&' Phone Memo 9/3/01 1.96K
l._|Phone Memo 9/3/01 1.96K
& To Do 9/3/01 2.55K
[]ToDo 9/3/01 3.02K
[ ] vehicle Milea... 9/3/01 T.32K
Edit Open [+ (]| @ /3 =
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Powering up device

Because the data and files you save on your device are stored in RAM, maintaining a
continuous power supply to the device at all times is extremely important. If your device runs
out of power, all information stored in RAM is lost. The preinstalled programs will not be deleted
even if your device suffers a loss of power; however, any custom settings and programs you
have added will be erased.

To safeguard data against loss in the event of power failure, you can save or back up files to NAND Flash
ROM(called “File Store” here). For more information, see “Backing Up and Restoring Data” in chapter 4
and “Managing Memory” in chapter 6.

Your device receives power from two sources: the main battery and the ac power adapter. The
following sections describe these sources. For tips on extending battery life, see “Managing
Power” in chapter 6.

Battery

The lithium-ion battery pack provides power to your device while it is not connected to ac power.
Actual battery life will vary depending on how you use your device. Some functions, such as
listening to music, using the backlight, or operating SD cards, use considerable power and may
reduce this time significantly.

The battery is charged whenever your device is connected to an ac power source—either the
AC adapter or the USB cradle. Usually, it takes 5 hours to charge your battery fully depending
on the battery status. Connect your device to AC power or place it in the cradle when it is not in
use, to ensure that the battery is fully charged when you need to take it with you. When the
battery is fully charged, charging stops automatically; the battery will not overcharge even if it is
left upon being connected to AC power.

When the battery charge is low, a low battery warning is displayed. If you see a
low battery warning message, connect to AC power and charge the battery
immediately to prevent possible data loss.
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AC Power with Cradle

To avoid running out of battery power, you can operate your device on AC power using the
supplied AC adapter. The AC adapter accepts 100 V to 240 V, enabling you to connect to AC
power anywhere in the world. When you travel, you may need adapters to accommodate
different electrical outlets, but the AC adapter will safely convert AC line voltage to the DC
voltage required by your device.

While your device is connected to AC power, the battery is charged automatically. The color of
the LED indicates the status of the battery:

Red indicates that the battery is charging, and
blue indicates that the battery is fully charged.

This LED shows you the status of extra battery
that may be seated on the back of this cradle.

Red indicates that the battery is charging, and blue indicates that the battery is
fully charged.

Turning device On and Off

One of the most convenient features of device is “instant on.” With instant on, there is no
waiting for your device to start up or shut down; you can start working immediately by pressing
the power button or one of the hot keys.

When you are finished working, turn off your device by pressing the power button. By default,
your device will turn off automatically after 5 minute of inactivity if it is not connected to an AC
power source. You can use the Power control panel to change these settings.

You can use the Power control panel to change these settings. On the Start
menu, tap Settings, tap the System tab, and then tap the Power icon.
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Using the Hardware Buttons

Hot Keys

The hardware buttons on your device (that is, the buttons on the device itself, rather than
buttons or icons that appear on the screen) can each be used to perform several functions,
such as turning on your device or starting a particular program.

The features associated with each button are described below. In addition, most buttons can be
reassigned or configured to start a program that you designate.

The hot keys can be reprogrammed to perform different functions or to open any program or
document you want. The descriptions below refer to the default functions. For more information,
see “Configuring Settings” in chapter 6.

B F ame

Tasks Calendar Contacts Voice Recording

Phone Status LED

Phone service area : Green flashing with a period of 20 seconds.
Not Phone service area : Red on.

When sending call signal, your call is connect : Blue on.

When receiving call signal, bell sound rings : Blue on.

Receiving SMS message : Blue on

When you have the received SMS message unread : Blue flashing.

using wireless internet : Blue on when transferring data, green on when receiving data.

Charging Status LED

B Blue indicates that the battery is fully charged.

B Red indicates that the battery is charging.

B Flashing Red indicates that the temperature of battery is higher than the standard
temperature. It is recommended to seat your device on the cradle again.

Up/Down Control button & Enter button

When your phone program is displayed on the screen but you are not connected to any other
person, press the enter button to display the last phone number you have called recently. At
this time, press the up/down control upward or downward to display the phone numbers you
have recently called. When you find a phone number you want to make a call, just press the
enter button.

While you are communicating with someone through CDMA module, press the up/down control
upward or downward to make volume higher or lower. In other words, if you press the up/down
control upward, then you can hear the voice of your partner louder through your device.

User’s Manual | 2-18



While you are communicating with someone through CDMA module, press the enter button to
end up this call.

Navigation Pad

Press the up/down control to scroll through documents or to highlight items in a list.

Chapter 2 Getting Started | 2-19



Caring for Your device

When treated properly, your device will be a reliable personal digital assistant. Follow these tips
to ensure long and trouble-free use of your device:

Protect the screen.

Pressing too hard on the touch screen may damage the screen. Use the stylus to tap the
device screen to avoid scratches or damage to the screen. To clean the screen, use a small
amount of commercial glass cleaner sprayed on a soft cloth. Avoid spraying the screen directly.
Be sure to turn off your device before cleaning the touch screen. If your device is set to power on when

you tap the screen, change this setting before you clean the touch screen.

Do not drop your device.

Dropping your device can cause damage to delicate components such as the screen.
Accidental damage is not covered under the warranty.

Avoid radiated interference.

Radiated interference from other electronic equipment may affect the appearance of the display
of your device. Removing the source of the interference will return the display to normal.

Avoid high temperatures.

Your device is designed to operate at temperatures between -20 to 60 °C (-4 to 140 °F). Using
the device at temperatures outside this range may damage the unit or result in loss of data. Be
especially careful not to leave your device in direct sunlight or in a car where temperatures can
rise to harmful levels.
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Chapter 3
Using Input Panel

@ In this chapter you have several options for entering new information:
- Block Recognizer

- Keyboard

- Letter Recognizer

- Transcriber
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Using the Input Panel

Use the Input panel to enter information in any program on your device. You can write
using keyboard, Block Recognizer, Letter Recognizer, or Transcriber. In any case, the
characters appear as typed text on the screen.

To show or hide the Input panel, tap the Input panel button. Tap the arrow next to the
Input Panel button to see your choice.

Options...

123' 1 | 2 | 3 | 4 |Ei Block Recognizer

Tablq[w]e][r
caP[a[s[d][f] * Keyboard
Shift] z [x | c |v | Letter Recognizer

ctlaii] - [\ ] Transcriber
Mew Edit ¥iew Tools *, ..

Block Recognizer

1]

i ' 127 @ p— Backspace

r Return
[ °
]

»—— Space
New Edi# Tools = 2~

4

1)1

el

»—— Punctuation & symbol

i

—— Input Panel for Block Recognizer

English entry area Number entry area

® Using Block Recognizer

1. Tap the arrow next to the Input panel button, and then tap Block Recognizer.

2.  Write a letter in the box.
When you write a letter, it is converted to typed text that appears on the screen. For
specific instructions on using Block Recognizer, open Block Recognizer, and then
tap the question mark next to the writing area.
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Keyboard

1231][2[3[4[s[6[7[8[9]0]-[=[4#]| Backspace
Tab/q|wle[r[t][y]uli|o][p]|[
CAPla[s[d[fla[h]j[k[1];]"]

shitf z[2[c[¥[b[n[m[,[.[/]+}| Retum
ctifaii] " [\ ] . L[4[t ]e]=

New Edit Tools (3 7

s

Punctuation entry Space

® To type with the soft keyboard

L Input Panel for Keyboard

1. Tap the arrow next to the Input panel button, and then tap Keyboard.

2. On the keyboard that is displayed, tap the keys with your stylus.

Letter Recognizer

*, Back space

| Tof 1

“IF

New En:*il: Tools = 2~

4

English upper/lower case entry area Number entry area

%7

Return

Space

Punctuation & symbol entry

\; Input Panel for Letter Recognizer
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® Using Letter Recognizer

1. Tap the arrow next to the Input panel button, and then tap Letter Recognizer.
2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For
specific instructions on using Letter Recognizer, open Letter Recognizer and then
tap the question mark next to the writing area.

Transcriber

o 4¢ 1:53

-
Arrow | m ﬁ ';I( ‘@ K ._|_-;_|%7 Settings
New Edit Tools (= 7 Mjilnput Panel for Transcriber

How to make strokes

Take turns selecting [IEILA.

Tap the punctuation & symbol entry button (ﬁ) to have the next window displayed.

o +
HHEENEE
(] y]=<|=]|/|Ta
CIT]L]}]\]e
(s |#|&|n]e
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Tap the Settings button() to have the next window displayed.

(3 |settings 3 ¢339 D

Transcriber: Options

Sound an
Show infra screen
Show iconbar

Inking
calor Width E = Select the width of pen and see
hal sample displayed below
Sample: ——

GEHEHIJ—REEQQWZET—J—— General tab of Settings

f:}' Settings

Transcriber: Options

Microsoft Transcriber 1.5 stdie)

Add space after ° Add space after entry
[ ] Separate letters made

— Speed of Recognition ws. Quality —
; 'l e Move the slide to right/left side to select speed
L and quality.
Speed ua ity
Fecognition start time
D 10 Move the slide to right/left side to select
recognition start time.
Shorter Longer
General | Reu:u:ugnizeﬁjl Recoanizer tab of Settinas
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Tap the L button to refer to how to make strokes.

fwj Letter Shapes ¢ 4 3:38 @

° Selected character

Tap on the shapes above for a demo

I wiite this ‘A’ Select one of 3 options according to how often you use
@) Often () Rarely () Newere the selected shape.

e COEFGHI JELMNOPQRSTUY

WHYZ1234567890 1 @Rdwn -t
([{-+_=.<7|| £¥2E @7 Tap these arrows to see more choices.
File [«

Tap the & button to have this window displayed.

X wlAlO] 7 &) x

With Transcriber you can write anywhere on the screen using the stylus just as you
would on paper. Unlike Letter Recognizer and Block Recognizer, you can write a
sentence or more of information; then, you pause and let Transcriber change the written
characters to typed characters.

® To type with Transcriber

1. Tap the arrow next to the Input panel button, and then tap Transcriber.

2.  Write anywhere on the screen.
For specific instructions on using Transcriber, open Transcriber and then tap the
question mark in the lower-right corner of the screen.
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Chapter 4
Connecting to Desktop

To get the most from your device, you will want to connect to your desktop or notebook
PC. This chapter describes how to establish the connection between your device and
your desktop PC, and how to synchronize and transfer files between your device and
your desktop (or any PC that has Microsoft ActiveSync installed).

® In this chapter, you will learn the followings :

- Install Microsoft ActiveSync and establish a partnership

- Full Backup & Restore using Backup/Restore of ActiveSync
- How to install programs using ActiveSync

- Connecting to Device
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Install Microsoft ActiveSync and establish a partnership

To get the most from your device, you have to connect to your desktop or notebook PC.
Microsoft ActiveSync enables you to synchronize the information on your desktop PC
with the information on your device. In addition, you can back up data from your device
to your desktop PC and restore this data to your device, and copy files between your
device and desktop PC. Before you begin synchronization, install ActiveSync on your
desktop PC from the provided Companion CD. By the way, ActiveSync is already
installed on your device.

First of all, insert Companion CD into the CD-ROM of your desktop PC and the CD-ROM
will begin automatically. Then, select Start and select Install ActiveSync 3.6. Just follow
the Installation Wizard that automatically begins to install ActiveSync 3.6.

After installation is complete, the ActiveSync Setup Wizard helps you connect your
device to your desktop PC, establish a partnership so you can synchronize information
between your device and your desktop computer, and customize your synchronization
settings.

This is an explanation on how to install ActiveSync 3.6, based on Windows 2000
Professional, so you may have a little bit different screen on the different OS versions
from below.

ou have chosen bo download a file from this location,

setup.exe from | WMSHACTSYNCWMain

‘what would wou like to do with this file?

™ Bun thiz program from its curent location

¥ Always ask before opering this tipe of file

oK I Cancel | Morelnfol

Select Run this program from its current location to install without saving.

Security Warning ﬂ

Do pou want to install and run "Microsoft ActiveSync 35"
zighed on 1/23/2002 10:23 &k and distributed by:

Microzoft Corporation
Publisher authenticity verified by Microzoft Code Signing
Caution: Microzaft Carporation asserts that this content is

zafe. You should only install view this content if you trust
Microzoft Corporation to make that azzertion.

[ Abways tust content from Microsoft Corporation

More Info

Click Yes to move to the next screen.
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Microsoft ActiveSync

Set Up Microsoft® ActiveSync® 3.5

Before you can exchange information between your mobile
device and thiz computer, you must set up ActiveSync.

Thiz setup wizard will guide you through:
Installing the ActiveSync program on this computer
Setting up your mobile device
Mote: |t iz strongly recommended that you exit all Windows
programs before continuing with this setup wizard.

Click Mext to continue with the setup process. Click Cancel
to quit setup.

< Back Cancel Help

Click Next.

Microsoft ActiveSync

Select Installation Folder
Install Microsoft® ActiveSync® in the default falder or create a new one.

®

ActiveSync will be ingtalled in this folder:
D:4Program FilesiMicrosoft ActiveSync

Click Change to select a different folder for installation of ActiveSync. Change... |

Space Required: 9967 K
Space Available: 2097152 K
< Back Cancel Help

Click Next.

Copying file: ceuninstdll

24 %

Cancel

When the process becomes 100%, automatically it will go to the next screen.

Connect USB port to desktop PC and the power cable to cradle. Then seat your device
into USB cradle.

Get Connected

Checking COM Ports
Please wait while Setup locates your mabile device.

“&ﬁ\%@

Progre:

Looking for a mobile device..
Checking on COM Part 1
Checking USE

< Back Hest s

Help |
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A wizard of finding a new hardware will begin automatically as below.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helpz you install a device driver for a
hardware device.

To continue, click Next.

Cancel

< Back

Click Next.

Found New Hardware Wizard

Install Hardware Device Drivers

A device driver iz a software program that enables a hardware device to work, with
an operating system.

Thiz wizard will complete the installation for this device:

@ 1USE Device

A device driver iz a zoftware program that makes a hardware device work. Windows
needs driver files for your new device. Ta locate diver files and complete the
inztallation click Mext.

‘what do you want the wizard to do”?

& Eearch for a sutable driver for my device [recommendedf

" Display a list of the known drivers for this device so that | can choose a specific
driver

< Back I Mest » I Cancel

Click Next.

Found Mew Hardware Wizard

Locate Driver Files
Wwhere do you want Windows to search for driver files?

Search for driver files for the following hardware device:

@ LISE Device

The wizard searches for suitable drivers in its driver database on wour computer and in
any of the following optional search locations that you specify.

To start the zearch, click Mest. If you are gearching on a floppy dizk or CO-ROM drive,
inzert the floppy disk or CD before clicking Mext.

Optional zearch locations:

[V CD-ROM drives
[T Specify a lacation
™ Microzsoft windows Update

< Back I Mest > I Cancel

Select CD-ROM drive and click Next.
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Found New Hardware Wizard

Driver Files Search Results o
The wizard has finizhed searching for driver files for your hardware device.

The wizard found a driver for the following device:

@ 1USE Device

Windows found a driver for this device. Toinstall the driver Windows found, click Mext.

@ iMtwoeusbshinf

< Back Cancel

Click Next.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

_\> Cyberbank JSB Sync

“windows haz finizhed inztalling the software for this device.

To cloge this wizard, click Finizh.

< Back

Lancel |

Click Finish and automatically the synchronization process will begin. And then the
following processes will appear on your desktop PC.
New Partnership x|

Set Up a Partnership

Thiz wizard helps you establizh a partnership between your
mobile device and this computer. You can set up either a
standard partnership to spnchronize data between pour
device and this computer, or a guest partnership to simply
transfer data between your device and this computer.

wihat kind of partnership would vou like to establizh between
your device and this computer?

| want to synchronize data between my device and
thiz computer, keeping data such as e-mail and
calendar items up-to-date in both places. .

o i Now, you are ready to synchronize
Guest partnership o —

| want to only copy and move information between my between your device and deSktOp PC, it

device and this computer, or add and remove may take a little Iong time to finish

programs. | do not want to synchronize data. . . .
synchronization. When it is in a state of

Guest, find files you want by pressing the

Explore button of toolbar.

< Back I Mest » I Cancel I Help |

Instead of synchronizing, you may set up your device as guest. Even though a guest,

you may transfer files and data between your device and your desktop PC.
When you perform hard reset or re-establish a new partnership after deleting the existing

Chapter 4 Connecting to Desktop PC | 4-5



partnership, you can select one of the options.

A desktop PC can establish partnerships with several devices while one device can
establish partnerships with up to two desktop PCs. However, you cannot synchronize
two devices with one desktop PC at the same time.

New Partnership x|
Specify how to synchronize data
Chooze to synchronize with your desktop and/or a server

*You can synchronize data, such as e-mail messages and calendar items, between your
device and thiz desktop computer. However, if you have access to a Microsoft Mobile
Infarmation Server with Microsoft Server ActiveSyne, you can also choose some information
types to synchronize directly with a server, getting the most up-to-date information, even when
your desktop computer is turned off.

Hows do you want to spnchronize with pour device?

& Sunchronize with thiz deskiop computer

" Synchronize with Microsoft Mobile Information Server and/or this desktop computer

[Mate: Y'ou must have access to a Microzoft Mobile Information Server with Server
ActiveSync to synchronize with a server. You will alzo need to have the necessary
information to configure your connection with the server. |

< Back I Mest » I Cancel Help

Click Next.

New Partnership x|

Select Synchronization 5Settings @

Select the tppe of information vou want to synchronize,

To synchronize a particular type of information, select its check box. To stop
synchronization of that information, clear itz check box.

Mobile Device I Desktap Computer I -

i ntGo AvantGo Channels ) )

W] 43 Calendar Microsoft Outlack _ Select any items you want to synchronize
2 Contacts Microsaft Dutlaok - and otherwise, deselect the others.

|# | Favorites Internet Explorer

I3 Files Synchronized Files 1.

@ Inbox Microsoft Dutlook,

D Motes Microsoft Dutlook, LI

To find out more about and o customize what gets synchronized, click Setings... |
oh that infarmation tpe in the list and then click Settings. =

< Back I Mext » I Cancel | Help |

Click Next.

New Partnership x|

Setup Complete

“Y'ou are now ready to start exchanging information between
your mobile device and this computer.

Upan exiting this wizard, Microsoft ActiveSenc will open and:

If pour device is a guest, click Explore on the toolbar and
start exploring vour device.

If your device has a partnership, synchronization starts,
Pleaze wait until synchronization iz complete before using
your device.

Click Finish to exit thiz wizard.

< Back Cancel Help
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Click Finish. Now, you are ready to establish a new partnership.

You will have the Microsoft ActiveSync screen as shown below.

43 Microsoft ActiveSync

Eile YWew Tools Help

=101 x|

@ O 5B 8 B

Sync  Stop || Details Explore Options
Pocket_PC2222e¢ — - ]

g
Connected

Synchronized

This is the partnership name that is
established with your desktop PC through
ActiveSync.

Information Type | Status |
{?‘-Calendar Synchronized

5 Contacts Synchranized

@ Tasks Synchronized ¢ |
[#IFavarites Synchronized

@Inbox Synchronized

These are the items you have selected for
synchronizing with desktop PC.

When you perform hard reset on your device, you need to change the partnership name
that is preset as Pocket PC. (for example : Pocket PC1, Pocket PC2, Pocket PC3,

Pocket PC4)

When you have some difficulties synchronizing your device with your desktop PC, click

the Connection Settings on the File menu to have the Connection Settings screen

displayed as below.

Connection Settings

% compLter
.

Statuz: Device connected

Click Get Connected ta connect vour mobile device ta this

[Het Connected.., |

X

[w iillow zenal cable or infrared connection to this COM port:

fcami

Statuz  COM port iz available

v Allow USE connection with this desktop computer.

Statuz  Connected

W Allow netwaork [Ethernet] and Femaote Access Service [BAS)

Statuz:  Metwork is available

]

Statusz icon

zerver connection with this deskiop computer.
’7 ¥ Show status jcon in Taskbar,

Ok Cancel Help
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Synchronizing Data

Synchronization compares the data on your device with your desktop PC and updates both

computers with the most recent information. For example, you can synchronize Microsoft
Word and Microsoft Excel files between your device and desktop PC. Your files are
automatically converted to the correct format. And you can synchronize e-mail messages in
Inbox on your device with e-mail messages in Microsoft Outlook on your desktop PC. And
you can keep your Pocket Outlook Contacts, Calendar, and Tasks databases up-to-dated by

synchronizing your device with Microsoft Outlo

ActiveSync options to select which information

ok data on your desktop PC. Use the
should be synchronized and to control how

much data is synchronized. By default, ActiveSync does not automatically synchronize all

types of information.

Sync Options | Schedulel Rules I

Desklop

L4

To synchronize a type of information, select its check box.
To stop synchronization, clear the check box.

[~

Tap Settings to customize the selected

Mobile Device

@ Calendar

@ Contacts

0 Tasks
Favorites
D@ Pocket Access
&l Notes i
(£ Files =

[V Synchronize mobile device clock upon connecting.

Settings..@ I|

Server
To enable, dizable or modify spnchronization with a server,

connect your device.
Lonfigure... |
(] I

[" Enable synchronization with a server.

Cancel |

Select Calendar and click the Settings button.

Calendar Synchronization Settings x|
Calendar Synchronization
Synchronize the appointments in Calendar on your mobile
device with Microgoft Outlook on this computer.
= Synchronize all appaintments.
o |

|2 VI past weeks of appointments and

Al

Synchronize only thaze appaintments in the following selected
categories:

¥ | future weeks of appointments.

<Mo Categaryy

Cancel Apply

o]

item.

Select any option you want to customize
Pocket Calendar during the synchronizations.
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Select Contacts and click the Settings button.

Contact Synchronization Settings

-

=~  Synchronize the contact information in Contacts on pour
mobile device with Microzaft Outlaok on this computer.

Contact Synchronization

nchronize all contacts.;

= &y

" Synchronize only the following contacts;

| First Mame | Company

Camm

Last Mame
e,
v 2 Bil Clinton
%2 Casey Taras
w12 Emilly Kim

G2 Esther Kim -
| | 3

~ Synchronize only those contacts in the following selected
categories:

@ <Mo Categary>

Wl

PaEY

D=

Task Synchronization Settings

0

Tazk Synchronization

Sunchronize the task and ather to-dao information in Tasks
on your mobile device with Microzoft Outloak, on this
computer.

 Synchronize all tasks.

& Synchronize only incomplete tasgks!

' Synchronize anly the

|2 vI pazt weeks of active tagks and

Al = | future weeks of active tasks.

= Synchronize only those tasks in the following selected categories:

<Mo Categony>
W

A

v ZHE
1Bt

Cancel

o]

Apply

Select any option you want to customize
Pocket Contacts during the synchronizations.

Select any option you want to customize
Pocket Tasks during the synchronizations.
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Select Favorites and click the Settings button.
Favorite Synchronization Options LI Favorite Synchronization Options LI

General |Cust0mize| General  Customize

Favorites Syunchronization Favorites Synchronization

Thiz service synchronizes your favarite links and Thiz service synchranizes your favarite links and
aszociated offline content from your desktop ta pour associated offline content from pour desktop to paur
mobile device. mobile device.

[ Synchronize offiine content pages

Offline Cantent

To conzerve the amount of space uzed by offling
content, pou can limit the types of content that are
synchronized to the device.

¥ Synchionize Images

¥ Synchronize Sound

Check 4l | Cearall |

ok I Cancel | ak. I Cancel

Select Inbox and click the Settings button.

il Synchronization Settings |

(A Mail Synchronization

" Sunchronize the e-mail messages in Mail on your mobile
device with gither Microsoft Outlook or Microgaft
Exchange on this computer.
Mail Folders
You have to select the folder you have
e+ made to be synchronized in the Inbox
program.
L1 Sent Items
¥ To save space, copy ot most 00 lines In this example, while synchronizing, it is
set as copy at most 100 lines to save
¥ Copy messages from the last [5 days space, copy messages from the last 5
[~ Includs file attachments days.

™ Limit attachment size o I KB
oK I Cancel

User’s Manual | 4-10



Select Files and click the Settings button.
File Synchronization Settings x|

File Synchronization

Synchronize selected files on your mobile device with the
conesponding files on this computer.

On thiz computer. spnchronize the files in this folder:

D:ADocuments and SettingshewkimiMyp DocumentsiPocket PC2g2 |

— Synchronized files

MName

Add.. | Eemaove |

[ o 1

Cancel |

This is the folder that includes the file
synchronized with your desktop PC. You
will find the Shortcut to the Files
icon(#1 )on your desktop PC.

After you customized ActiveSync and completed the first synchronization, you can control

when synchronization occurs by selecting a synchronization mode.

x|

Sync Options  Schedule | Fiules I

Desktop schedule

& Continuousl while the device is connected -

Synchronize automatically whenever the infarmation
changes on either the mobile device or desktop computer.
' Only upon connection
Synchronize automatically each time that the mobile device
iz connected to the desktop computer.
© Manually

Only synchronize information in responze to clicking the
Sync button on the toolbar, or clicking Synchronize on the
File: menu.

Server schedule

(ﬂ v ‘when connected to my PC, synchronize every:

I 5 Mirutes =

[~ “wWhen not connected to my PC, synchionize eveny:

IED Minutes x

ok I Canze
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Copy, Paste and transfer files

Select the file(s) you want to copy an

d select Copy on the Edit menu or select Copy on the

pop-up menu. For pasting file(s), select the Explore button on the Microsoft ActiveSync

screen of your desktop PC to have the Mobile Device screen displayed as below :

ﬁ Mobile Device _ Ol x]|
J File Edit ‘iew Favorites Tools  Help |
J 4=Back -~ = - | @ search [ Folders  £HHistory | S OE o =
Jnc_ldress I B Mobile Device j @GD
L ] B © ©
i My Pocket PC Annotations Eusiness
Mobile Device
Select an item ko view its ___j ___j @
description. -
Personal Templates Cliff
Rechard-Ea...
g
Livin' la vida Moke 1, pwi scarlet.lit
Loca.mpd
|9 ohject{s) | | B Mobile Device

First, select the folder you want to paste and select Paste on the Edit menu or select Paste

on the pop-up menu.

However, when you transfer file(s) be

tween desktop PC and your device, files created on

your desktop PC may automatically need to be converted before you can use them on your

device, and also files created on your

device may automatically need to be converted before

you can use them on your desktop PC. However, when you work with software such as
ClearVue Presentations or ClearVue Image, files should not be converted to the different
format. In other words, those software use the format identical to the corresponding
software of your desktop PC. That’s why we need to change the settings of converting
file format when files don’t need to be converted before you can use them on your

device.

You can change the settings as follows :

Sync Dptlnnsl Schedule Fules |

Conflict Resolution
4='=> If there is a conflict (an item has been changed on both
-" the mobile device and desktop computer or server]

Desktop:

Leave the item unreso

Server Always replace the item on my device

[~

File Conversion

t% or synchronized between this computer and pour mobile
device.

B ¢

Set how files will be converted when they are copied, moved,

Tap the Conversion Settings to change
the options for conversion between

anversion Settings.. L4

desktop PC and your device while

Pasz Through

To uze pass thiough, this computer must be connected.

LConnection: |The Irnternet

[~

¥ DOpen ActiveSync when my mobile device connects.

copying, pasting and synchronizing.

Cancel |
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Select Conversion Settings.
Pocket_PC2222 File Conversion Properties ﬂ

General | Device to Desktopl Deskiop to Devicel

During conversion, desktop computer files get transformed
1 D into their comesponding file types on the mobile device, and
: ¥iCE Yersa.

Filez do not have to be converted, However, pou may not
be able to open unconverted files using the programs on
your device.

Deselect this option box not to change the

v Conwert files when synchronized, copied or moved P
file format.

n] I Cancel Help
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Full Backup & Restore using Backup/Restore of ActiveSync

You can back up files, database, PIM data and programs installed in RAM to your
desktop PC using Microsoft ActiveSync, and restore them when needed.

Backup can either be performed automatically when your device is connected to your
desktop PC, or manually whenever needed. Also, you can back up updated or new data
only or choose to back up all data.

Automatic backup is only possible when a Partnership is established with a
desktop PC. Only a manual backup is possible when the partnership is
established as Guest. For more information on Backup/Restoring to and from a
desktop PC, see Microsoft ActiveSync Help.

Backup

1. Connect your device to desktop PC.

2. Tap Backup/Restore on the Tools menu of the ActiveSync screen.

Backup,/Restore 5'
Backup | Hestorel

"— Uze Backup to create a file on thiz computer that containg
= all the filez, databazes, personal information, Rak-bazed
programsz and other information currently on your mobile
device.

= Ful backup ) ° Full backup
Back up all information.

&' Incremental backup
= . . . [ ]
Back up only the information that has changed zince the Iast; Incremental backup.

hackup.

Back up to this file:
reSuncitProfiles W Pocket PC2222%WE ackup.stg Chahge... ® | Tap Change to change backup

name.
Click Back Up Mow to begin backing up your Back Up How
mobile device,

[T Autoraticaly back up each time the device connects.

Tap Back Up Now to begin.

ak. I Cancel |

3. Select “Full backup” or “Incremental backup” according to your needs.

4. You may need the backup file name and the folder when restoring your backup file.
Tap the Change button to confirm the folder.
5. Tap the Back Up Now button to begin.

Backup In Progress |

o g

Mow backing up to 'Backup.stg'
Flease do not use the device until backup is finished.

[

Copying: My Documents¥Livin' la Yida Loca. mp3
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Do not remove your device from the cradle or disconnect the USB cable during

backup.

Restore

As newly installed programs or new files created on your device since your last
backup will be lost after restore, you should move them to your desktop PC or to
File Store (NAND Flash memory) before you restore data.

1. Connect your device to desktop PC.
2. Close all programs running on your device.
3. Establish a partnership as Guest.

New Partnership

Set Up a Partnership

Thiz wizard helps you establizh a partnership between your
mobile device and this computer. You can set up either a
standard partnership to synchronize data between your
device and this computer, or a guest partnership to simply
transfer data between your device and this computer.

Wwhat kind of partnership would you like to establizh between
your device and this computer?

| want to synchronize data between my device and
thiz computer, keeping data such as e-mail and
calendar items up-to-date in both places.

' Guest partnership

| want to only copy and move information bebween my
device and this computer, or add and remove
programs. | do not want to synchronize data.

o |

| Select this options box to set
up your device as guest.

< Back I Mest » I

Cancel I Help

4. Tap Backup/Restore on the Tools menu of the ActiveSync screen, and select the

Restore tab.

Backup/Restore

Backup Festore I

f’ Use Restore to remove all current information from your

= mobile device and replace it with the contents stored in
the backup file.

T o restare successfully, quit all programs on vour device before starting
the restore process. Alzo, do not use vour device until the restars
process is complete.

Mate: You cannot cancel the restore process once it has started.

Click Restore Mow ta begin restaring your
mobile device.

=]

Cancel
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5. Tap the Restore Now button.

Partnership Selection |

I the list, zelect the partnership file that containg
your backup file. Click Browse if your backup file iz
nat stored with your partnership file.

Guest

Pocket_PC2222 Browse... |
{i]8 |

6. Select the backup file you want to restore and select OK to begin.
Proceed with Restore? x

Restore will remove all curent data from your
device. Your data will be returned to the state it

was when thiz backup file was last updated.

Mate: You cannot cancel restare after it has
been started.

Froceed with Restore?

Bestore |

7. Click Restore to begin the restore process.

=

Mows restaring from 'Backup. stg'

Fleasze do not uze the device until restore iz finished.

[

Copying: ¥indows¥messaging®0c001 c2610000071F, mp

Restore In Progress

8. When completed, perform soft Reset on your device with your stylus and seat your
device on your cradle to synchronize.

Do not use your device until Restore is completed.
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How to install programs using ActiveSync

Using Setup.exe or Install.exe

1. Download the program to your desktop computer (or insert the CD or disk that
contains the program into your desktop computer).

2. Connect your device to your desktop PC.

3. If the program includes an installer program (typically named Setup.exe or Install.exe),
double-click the installer program on the desktop PC. The installer program copies the
necessary files to your device.

Using cabinet (*.cab) file

1. Download the program to your desktop computer (or insert the CD or disk that
contains the program into your desktop computer).

2. Connect your device to your desktop PC.

3. Use the ActiveSync Explore button to copy the cabinet (*.cab) file to the Program Files
folder on your device, and then double-tap the icon on your device to install the program.
4. Refer to the Read Me file or documentation that came with the program to be sure you
have copied the necessary file(s). For more information on copying files using
ActiveSync, see ActiveSync Help.
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Connecting to Device
Connecting by USB Cradle

Using the USB cradle, you can charge and synchronize your device at the same time
even though the charging circuit is not included on your cradle.

Keep your device in the cradle when you are not carrying it with you, so it is always
charged, synchronized, and ready to go.

Turn off your device or remove it from the cradle before you shut down your desktop PC.

Before you connect, be sure of the following: your desktop PC is on, you have
installed ActiveSync on your desktop PC, and ActiveSync is configured to allow a
USB connection.

When you remove your device from the cradle, hold the cradle with one hand, and gently lift
your device with the other to avoid putting stress on the connectors.

1. Connect your device to your desktop PC as below:

2. How to use the Infrared port of your device:

The infrared port on your device provides a convenient way to connect to an IrDA-equipped
PC without using a cable or cradle. Many notebook computers have built-in infrared ports;
however, you may need to install and configure an infrared port on a desktop PC. To install
the port, follow the manufacturers instructions.

Windows 95 and Windows NT® do not support USB or infrared connectivity.
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Chapter 5
Using the Internet & E-mail

In addition to connecting your device to your desktop PC, you may want to connect to
remote computers so you can access e-mail, browse the Internet, or retrieve files from a

corporate network, whether you are at home or on the road.

® To start the connection, simply open a program that requires a connection to the

Internet. Your device will attempt to connect automatically.

B Visit Internet or intranet Web or WAP pages by using Pocket Internet Explorer.

B Send and receive e-mail messages by using Inbox. Before you can use Inbox, you
need to provide the information it needs to communicate with the e-mail server.

B Send and receive instant messages with MSN Messenger. For more information, see

“MSN Messenger” in chapter 9.
® This chapter describes

— browsing the Web using Microsoft Pocket Internet Explorer and Mobile Favorites

— sending and receiving e-mail messages
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Browsing the Web from your device

You have to set up the Internet Settings before you use the Internet Explorer for the first
time. For more information, refer to the Internet Settings section later in Chapter 6.
Once you are connected to an ISP or to a network, you can browse the Internet or a
corporate intranet. You can also use Pocket Internet Explorer to browse Web and WAP
content while you are not connected—by downloading mobile favorites and channels to
your device.

Using Microsoft Pocket Internet Explorer

Use Microsoft Pocket Internet Explorer to view Web pages in either of these ways:

B Connect to an ISP or network and browse the Web. To do this, you will need to
create the connection first.

B During synchronization with your desktop PC, download mobile favorites that are
stored in the Mobile Favorites subfolder in Internet Explorer on the desktop PC.

While you are connected to an ISP or network, you can also download files and
programs from the Internet or an intranet.

To start Pocket Internet Explorer

1. On the Start menu, tap Internet Explorer.

.'{1}1 Inkernet Explarer o< 10:57 9

Tap below For useful sites and services!

'. PocketPC.com

CYISERIBANK

msn* Mobile
@ AvantGo®

View Tools 4 @ @ I?] W&—E—|—~ Hide Picture button

Refresh button

‘ Mobile Favorites button

Home button

2. On the View menu, tap Address Bar.
3. Enter address you want on the address bar located on the top of screen and tap the
arrow next to the address bar, then it will automatically connect to the Internet using
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CDMA module.

4. When the internet connection is completed, the internet connect ( [ ) icon will
appear on the Navigation bar.

5. When you want to finish using Internet, tap the stop (o) button on the Command bar
so that you have the Internet browse () icon stopped. And also you need to tap X on
the right-upper corner and tap the Internet connect (m) icon and tab the End button on
the Connected pop-up screen to stop your Internet connection completely.
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Mobile Favorites folder

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet
Explorer on your desktop PC will be synchronized with your device. This folder is created

automatically when you install ActiveSync.

You can only view the mobile favorites offline that was synchronized with your desktop

PC. If the page is not synchronized with your desktop PC, it will be dimmed in the
Favorites list of your device. You will need to synchronize with your desktop PC again to
download the page to your device, or connect to the Internet to view the page.

To make Mobile Favorites

1. Select Options on the Tools menu or click the Options button to have the Options

screen displayed. Then select the Favorites check box and click OK.

Gyne Options |Schedule| Fiules I

Desktop

To synchronize a type of information, select its check box.
To stop epnchronization, clear the check box.

M obile Device

I -~ Settings... |

O @ Calendar
2 Contacts
O @ Tasks
:Favorites
[1%] Pocket Access
@ Ik

CIE Moates

[I[£¥ Files

V¥ Synchronize mobile device clock upon connecting.

[

Server

To enable, dizable or modify synchronization with a server,
connect your device,

[ Enable synchrarization with a sereer Lanfigure... |

Ok I Cancel I

2. Select Create Mobile Favorites on the Tools menu of Microsoft Internet Explorer of

your desktop PC.

Create Mobile Favorite

This will zend the page ta your mobile device.

Harmne:

0K

Cancel

dil

Update: IDD not schedule updates

j Create In»» |

3. When you select OK, the Internet Explorer will download the latest version of the
corresponding page. Then you will find the icon(-@) on the task tray bar of your desktop

PC.
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To make the Mobile Favorites button on the Tools menu of

your desktop PC

Select Tools bar > Customize on the View menu of Microsoft Internet Explorer to add the
Mobile Favorites button on the Tools bar.

Customize Toolbar

Ayailable toolbar buttons:

Separator -

[ Up

=) Map Diive Add |

i Disconnect

L Folders <- Bemaove |

E Full Screen

% Size

& Cut -

1| BEr
Text options: ISeIective text on right j
Icon options: ISmaII icans j

2lx
Current toolbar buttons: Close I

Separator ;I
2 Mail N

= Frirt

! Edit
Discuss

[@ Create Mobile Favorite Move Up |
Separator
<[ [fove Qownl

1| |

Select Create Mobile Favorites on your left pane and click the Add button to send that

item you select to the right pane as described above. Then you will find the Mobile
Favorites() button on your tools bar of your Microsoft Internet Explorer.

To reduce the amount of memory caused by Mobile Favorites

Mobile favorites take up storage memory on your device. Follow these tips to minimize

the amount of memory used:

B Use ActiveSync settings to turn off pictures and sounds for the Mobile Favorites or to
stop some mobile favorites from being downloaded to your device. For more

information, see ActiveSync Help.

1. Select Options on the Tools menu or click the Options button to have the Options

screen displayed.

Gyne Options |Schedule| Fiules I

Desktop

To synchronize a type of information, select its check box.

@ To stop epnchronization, clear the check box.

O @ Calendar
2 Contacts
O @ Tasks

[1%] Pocket Access
@ Ik

|:| MNotes fa
[I[£¥ Files =]

V¥ Synchronize mobile device clock upon connecting.

Mobile Device I -~ Settings... |

Server

@ To enable, dizable or modify synchronization with a server,

connect your device,

[ Enable synchrarization with a sereer Lanfigure... |

[ o ]

Cancel I
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2. Then select the Favorites check box and click the Settings button.

Favorite Synchronization Options : 5'

General Customize I

Favorites Synchronization

Thiz zervice synchronizes your favorite links and
azzociated offline content from your desktop to wour
mobile device.

v Bynchronize gf.f.iine content pages

Offline Cantent

To conzerve the amount of space used by offline
cohtent, you can limit the types of content that are
gunchronized to the device.

¥ Synchronize mages
¥ Synchronize Sound

ak. I Cancel I

3. Deselect pictures and sounds for the Mobile Favorites and click OK.

To view Mobile Favorites offline

1. Tap the Favorites ( IZi ) button on Pocket Internet Explorer of your device to display
your list of favorites.

Internet Explorer T =2 2:27 @
Favorites

= Mobile Favorites

4 swantGo Channels
[ Packet PC web Guide
B Pocket PC.com
{8} WindowsMedia.com
] Packet PC Thoughts - News, Wiews,

° Tap the favorite you want to view.

Cpen | Add [ Deletg!

Tap to add or delete a folder or favorite link.

E|‘

2. In the list, tap the page you want to view.
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Sending and Receiving E-mail

If you have an e-mail account with an ISP or on a corporate network, you can use Inbox

to send and receive e-mail messages in two ways:

B Synchronize e-mail messages with Microsoft Outlook on your desktop PC.

B Send and receive e-mail messages by connecting directly to an e-mail server

through an ISP or a network.

Synchronizing E-mail Messages

You can synchronize e-mail messages as part of the general synchronization process

whenever you connect your device to your desktop PC. First, you must enable Inbox

synchronization in ActiveSync.

Select the Options button on the Microsoft ActiveSync screen.

Sync Optiohs | Schedulel Rules I

Desktop

@ To synchronize a type of information, select its check box.

To stop synchronization, clear the check box.

O @ Calendar

2 Contacts

O @ Tasks

(=] Favorites

D@ Pocket Access

& Nates f
I Files =l

v Synchronize mobile device clock upon connecting.

Server

obile Device | - Settings... |

To enable, disable or modify synchronization with a server,

LConfigure... |

connect your device.

[ Enable synchronization with a server.

o]

Cancel |

Select Inbox and click the Settings button.

Chapter 5 Using the Internet & E-mail | 5-7



Mail Synchronization Settings x|

fA Mail Synchronization

T Sunchronize the e-mail messages in Mail on your mobile
device with either Microzoft Outlook. or Microzoft

Exchange on thiz computer.
Mail Folders

D@ e — | Select the folders you have made to synchronize.
e CI5E mymusic

@ Outbox

¥ To save space. copy at most: 0o lines

¥ Copy messages from the last: |5 days

[~ Include file attachments

= Limit attachment size fo; I kE
ak. I Cancel |

Make selections as you want and click OK to copy the Inbox folder of your desktop PC to
the Inbox folder of your device.

Here is the list of mail messages after you synchronize through ActiveSync.

Tx 4% 3:48 6

Inbox - Received Date -

Ee Shockwmawe,com 741 AM 14
Zatch the hit series Featuring Wallace. .
HizH 21221075 oK |
Mews From the American Anki-Aging So...
Placetare 2121103 K —
Award-winning sales toal, Mo cost krial,
gschung 2120003 2139
Fi's RRL Certification For CYEERBAME,

ewskim 21903 2161k Shows you this is a mail message with attachments
P that need to be downloaded.

Roy ak SEVEMEwen,.. 2/6/03 4K
RE: thank wou very much & have aw...

7 117403 4K
Fw: [Cvberbank] Schedule For Pretest, .,
T 117103 z0/138K |
Fw: [Cyberbank] Schedule For Pretest,,, | =

Inboix: AckiveSync 36 Ikems,

Mew Tools Services @ % E|‘

= — Shows you this is a read mail message.

®PP% % DR

B This is unread message.

@ This is unread message with attachments that need to be downloaded.
1 This is already read message.

This is read message with attachments that is already downloaded.
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If you want to download the attachments, tap and hold the corresponding message to

have pop-up menu displayed. Then select Mark for Download.

Ty =% 3:51 9
Inbox - Received Date
& Shockwavwe, com 741 AM 0K | &
atch the hit series Featuring Wallace... [
& HGH 2j22103 oK |=
Mews From the American Anki-Aging So...
& Place'w'are 2121103 T —
Award-winning sales tool, Mo cosk trial.
@- gschung 2120003 2139k
Fity': RRL Certification For CYEERBAME
i wskim 190035 z2/6lk
Mark as Unread
Move To... 26103 4K
h & have aw...
Mark For Download 17(03 Sk
Repl Lle Far Pretest, ..
epy 17)03 20/135K
Reply All Jle For Prekest,..,
Forward
Delete

I B
Then this icon will be changed to .

Using the Message List

Messages you receive are displayed in the message list. By default, the most recently

received messages are displayed first in the list.

Inbox ~ Received Date vo-—— Select the sort order for messages.

&y Shockwave.com 74l A 0K [«
akch the hit series featuring Wallace... [

(&) H&H 2122)03 oK |=
Mews From the American Anki-A4ging So...

= Placew'are z2iz1j03 T —
Award-winning sales tool, Mo cosk krial.

@- aschung 2iz0i03 2139k
Fit': RRL Certification For CYBERBAME

@ yskim 219/03 261k
Fhi:

&y Roy at SEVEMtwen. .. 216/03 4K
RE: thank wou wvery much & hawve aw. ..

& 7 1/17)03 24K
Fuv: [Cwberbank] Schedule For Pretest. ..

B 7 1/17/03 20/135K |
P [Cyberbank] Schedule For Pretest, ., | ™

Inbox: ActiveSync 36 Ikems.
Mew Tools Services g % E|4

Tap to connect to the
selected service.

— Tap to connect and to send and receive e-mail.
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When you receive a message, tap it to open it.

Tx £ 4:01 @ Tap to return to the message list.
Fram: "Place'Ware "
<mailbox@post .com =

Subject: Award-winning sales kool Mo cost
krial,

Sent: 2/21J03 6:06:51 AM

[y e |

This rail is never sent unsolicited, This
is ar internet.com mailing

delivered by PostMasterDirect, You
have subscribed to receive this
infarmation at one of the internet.com
Metwork sites (see

btbp: e internnn.com for & complete

| L CB-24... F)CB-2470...
#]CB-2470

New Edit &3 @‘ i E|*

Tap to delete this message.

Tap to view the previous or next message.

Tap to reply to or forward this message.

You can mark the messages that you want to retrieve in full during your next
synchronization. In the message list, tap and hold the message you want to retrieve. On

the pop-up menu, tap Mark for Download. The icons in the Inbox message list give you
visual indications of message status.

When you select this message with attachments that is already downloaded, the
message will open with attachments displayed on the bottom of screen.

Fram: "Place'Ware "
<mailbox@post . com =
Subject: Award-winning sales tool, Mo cosk
krial,
Sent: 2)21/03 6:06:51 AM

This rnail is never sent unsolicited, This
is an internet.com mailing

delivered by PostMasterDirect. ou
have subscribed to receive this
infarmation at one of the internet.com
Metwork sites (see

btbp: e, internnn,com for & complete

ML
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Tap the attachments to open the corresponding file as shown below.
2B Pocket Word Tx % 4:16 @

Merlin Logo Test Kit
Release3 2003/01/16
Complete Pass/Fail

Checklist

Device: CyberBank

POZ/CB-1870 016 KOR

Test Dates:  2003/01/15

17:41:35 to 2003/01/16

Z0:06:31  Summary
61%0 Complete
1 Non-Passing

Issues Pending
Description of result codes: 45 |+

[ »

Mew Edit ¥iew Tools T, E|4

Make a new message

1. Tap New.

Tap to send the message.

Tx % 6:36 @
Send|5ubj < ... > ¥®—— Tap to show or hide the complete header.
123/1[2]|3[4|5]6|7][a[o|0]-[=]w

Tabjafwle[r[t|y[uli|o[p]l
caP[a[s[d[fa[n]jifk[I];]"
shift] z [2 [c [v [b[n]m]. [.]
ctfad]” [\ ] LTt
New Edit My ’TEHI:E =

r_l Tap to display the Address Book.
-3

—

[
1
—

8

Tap to insert common messages. Tap to show / hide the recording toolbar.
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2. Inthe To field, enter an e-mail address of one or more recipients, separating them

with a semicolon, or select a name from the contact list by tapping the Contacts

button.

#ab|cde| foh| ik [ Imn|opal rst [uw] sz

Ale Comm alecomm@piscel...e o
Bill Clinton billclinton@com... & [=
Casey Taxas taxas@western.c..e |
Emily Kim emilykim@comm...e
Esther Kim estherkim@com... e
Grace Kim gracekim@com... e
Ihsan Muse ihsanmuse@com...e [
1231[2]3]4[5]6|7|a[o]0]-[-[«
Tab[q[wle|r[t[y[u|i[o[p[[]]

t_

cap[a[s[d[f]a[h[j[k][I[;]

shift[z[=[c[v[b[n[m][.[.[/]
ctlai] - [\] [4[t]<]-
New Edit My TeutEl |E*

3. Compose your message. To enter preset or frequently used messages, tap My Text

and select a message.

Tx 4% 6:40 (O

= | T ==

Subj ... =

<

Yes.

MNo.

I can't talk right now.
I'll be right there.
I'm running late.
Where are you?

1231 2] -y
Tab[aly ([
EAF"| = | Goodbye. :

Shift] z | Call me later. J'|—1“_,
ctlaii[ | Ilove myPocketPC! [ [

New Edit|My Text|[=] = =]+

4. When you have finished the message, tap Send.
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Delete a message

When your device is synchronized with your desktop PC, and when you want to delete a
message on your device, tap and hold the message to have pop-up menu displayed.
Then select Delete.

Inbox Tx =% 3:51 9
Inbox Received Date -
& Shockwavwe, com 741 AM 0K | &

atch the hit series Featuring Wallace... [
& HGH 2j22103 oK |=
Mews From the American Anki-Aging So...
& Place'w'are 2121103 T —
Award-winning sales tool, Mo cosk trial.
@- gschung 2120003 2139k
Fity': RRL Certification For CYEERBAME
i wskim 190035 z2/6lk
Mark as Unread
Move To... EI603 4
h & have aw...
Mark For Download 17(03 Sk
Repl Ule For Prekest. ..
epy 17)03 20/135K
Reply All Jle For Prekest,..,
Forward
Delete

If your device is not synchronized with your device, the next time your device is
synchronized, the corresponding message on your desktop PC will be deleted.

Reply, Reply all or Forward a message

When you want to reply, reply all or forward a message on your device, tap and hold the
message to have pop-up menu displayed. Then select Reply, Reply all or Forward.

Inbox - Received Date -
= Shockware,com 74l A 0K [«
akch the hit series featuring Wallace... [
& HGH 2/2203 oK |=
Mews From the American Anki-A4ging So...
= Placew'are z2iz1j03 T —
Award-winning sales tool, Mo cosk krial.
@- aschung 2iz0i03 2139k
Fit': RRL Certification For CYBERBAME
i yskim 1905 2/61K
Mark as Unread
Move To... EI6/03 4K
b & have aw...
Mark for Download 17(03 Sak
Reply ble For Pretest, .
Reply all
Forward
Delete
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Connecting Directly to an E-mail Server

In addition to synchronizing e-mail messages with your desktop PC, you can send and
receive e-mail messages by Inbox on your device using CDMA module.
The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway.

Customize a new mail service

You can use multiple e-mail services to receive your messages. For each email service
you intend to use, first set up and name the e-mail service. If you use the same service
to connect to different mailboxes, set up a separate service for each mailbox.

In Inbox, tap Services, and then tap New Service. Follow the directions in the New
Service Wizard. Here is just parts of setting a wizard.

Ty 4% 4:32

E-mail Setup {1/5) (2]
E-mail address
Erter e-mail address: | |

|Eancel || Back || Mext |
123(1[2]|3[4|5]6[7]g8][0|0]-]=]
Tablq|wle[r[t[y[ulio[p[[]]
CaPlals[d[fla[h]j[k[I];]"]
shift[z[2[c[v[b[n[m[.[.[/]+
ctlai] - [\ ] [V]t]e]~>

Edit > |E -
Enter e-mail address and tap Next.
Tx £ 4:34

E-mail Setup (2/5) o

Auto configuration

Attempting to automatically configure wour
e-mail settings,

To skip this step, tap Skip.

Skakus:

IEancEI || Sskip || Back || Mexkt |
12312 [3[4[5|6]|7(8[9|0]-[=[«
Tabjq|wle|r|t[y[ulifo[p|[]]
CAPla|s|d[flg[h[j[k[I[:]"]
shift] z [2 [c[v[b[n[m[,.[. /]«
ctlaiil - [1] [L]t]<]>

Edit < @j
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After the status becomes Completed as shown above, tap Next.

Ty =% 4:35
E-mail Setup {3/5)

User information

Your name: || |

User name: |5Wkil‘l‘| |

Passward: | |

|:| Save password

|Eancel || Back || Mext I
123(1[2]|3[4|5]6[7]g8][0|0]-]=]
Tabja|wle|r[t[y[ufifo[p|[]]
CAPla[s[d[fla[h[i[k[I]:]"]
shift|z [x [c[v[b[n[m[,|.[/]+
ctlai] - [\ ] [V]t]e]~>
Edit |Ea~

Ty % 4:37
E-mail Setup {4,5)

Account information

MName: (POP3

|Eancel || Back || Mext I

123(1[2]|3[4|5]6[7]g8][0|0]-]=]

Tabla[wle[r[t[y[uli[o]p|[]]
CAPla[s[d[f[alh[jlk[1]:["]
shift[z[2[c[v[b[n[m[.[.[/]+
ctfaia] - [\ ] [V]t]e]~>
Edit 3 |Ea~

Select POP3 or IMAP4 that is supported,

enter a name in the Name box (for
example, My Mail).
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Enter a name in the Name box (for example, My Mail) and tap Next.

Tx =% 4:39

E-mail Setup {5/5) (2]

Server information

Incaning mail: || |
Cubgoing mail; | |
Du:umain:| |
|Eancel || Back || Finish |
123[1[2[3[4[5[6]7[8[0]0]- [=]+
Tab[a[wle[r[t[y[u[i[o[p[[]]
caPla[s[d[fa]n]iJk[1]:]"]
shift| z[x[c[v[b[nm[,[.[/]+
culaia] " [\ ] [4[t[<]>

Edit 3

If needed, tap the Options button.
Tx 4% 4:41
Advanced (1/3) 0

Options
Check For new messages every

minukeds)

|:| Cukgoing e-mail server requires
authentication

Connection: |Default Internet Settin v|

|Eam:e| || Back || Mexk I

123(1[2]|3]4|s5]a[7]8][o|0]-]=]

Tabja|wle|r[t|y[ulifo|p[L

capla[s[d][fla]n]ifk[1];]"

shift[z [z [c[v[b[n[m[.[.[/]+
culaia] - [i] [Vt ]e]~>
Edit X |Ea~

Enter server names in the Incoming mail

box and the Outgoing mail box(for example,

**** cb.co.kr), and if needed, tap Options to
set the other options. For more detailed
information, ask your the network
administrator or corporate mail-server
administrator.

Check for new messages every 15
minutes.
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T 4% 4:43
Advanced (2/3) e

Options

Select one of options provided: Get
message headers only, Get full copy of
messages. When you select Get full
copy of messages, also you will
receive messages from file
attachments of less than 25 KB in
size.

|Eam:e| || Back || Mext I
123(1[2]|3[4|5]6[7]8][a|0]-]=]
Tabjq[wle[r[t[y[ulifo[p|[
cap[a[s[d[f]a]n]ik]I];:]"
shift] z [ [c [v[b[n[m]
crlain] = [\ ]

Edit @j

Tx ™€ 4:a4
Advanced (3/3) 0

1~
—

Options

Only display messages From the Only display messages from the
last davvs e last3days.

|Eam:e| || Back “ Finish I

12312 [3[4[5|6]|7(8[9|0]-[=[«
Tabjg|wle|r [ty [ulijo|p|[
caPla[s[d[r[a]n][i[k[1];]"
shift] z [x [c [v[b[n[m],
cufaia] - [i] |

Edit < @j

Tap the Finish button.

—

Chapter 5 Using the Internet & E-mail

5-17



To connect to an e-mail service

In Inbox, tap Services, and then tap Connect. Then through CDMA module, you will be

connected to mail server. Messages in your own local folder will be downloaded from this
mail server directly.

flInbox Tx % 4:46 9
Show Received Date
-2 ActiveSync
=] @ POP3

f:ﬁ' Deleted Items

nibo
----- ‘\‘?r;S Outho
----- -3y Sent Ttems

Choose Falder, ..
Mew Tools Services :E- E|4

To synchronize your own local folder through ActiveSync

If you want to synchronize your own local folder through ActiveSync, select the local
folder(for example, POP3 as shown below) and on the Tools menu, select Manage
Folders.

Inbox Tx W% 4:47 @

Manage Folders

Select folders for synchronization,

=@ pop3
------ '.f:ﬁ' Deleted Itermns

5 Jglaery
----- ’f?gﬁ Outho
----- ) Sent Items

New Tools Rename B E|“

Select the subfolder you want to synchronize through ActiveSync and tap OK on the
upper-right corner.
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By default, each mail service is composed of 5 subfolders.
® Inbox

® Outbox

® Sentltems

® Deleted Items

® Drafts

When you connect to the e-mail server, new messages are downloaded to the Inbox
folder on your device, messages in the Outbox folder are sent, and messages that have
been deleted on the e-mail server are removed from the Inbox folder on your device.

You can work online or offline. When working online, you read and respond to messages
while connected to the e-mail server. Messages are sent as soon as you tap Send,
which saves space on your device.

When working offline, you should download new message headers or partial messages,
and then you can disconnect from the e-mail server while you decide which messages to
download completely. The next time you connect, Inbox downloads any messages you
marked for retrieval and sends the messages in your Outbox folder.

To leave a copy of messages on Server

Once when you download mail messages on your desktop PC or device from mail server,
the mail messages will be deleted on mail server. You need to leave a copy of messages
on mail server.

Here is an explanation on how you can leave a copy of messages on mail server on your

desktop PC. Select Services on the Tools menu.
' 21

Services | Delivery | Addressing |

The Following infarmation services are set up in this profile:
Inkernet E-mail - Cvberbank.
Outlook Address Book
Personal Folders
[ -]
Add. .. | Remove |
Copy... | About. .. |
(] | Cancel | Apply | Help |

Then click Properties and click the Advanced tab.
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¥ Cyberbank Properties |

Generall Serversl Connection  Advanced |

Server Port Numbers

Dutgoing mail [SMTP): I Use [efaults |

[~ Thiz server requires a secure connection (S50

Inizarning mail [POP3): |1 10

[~ This server requires a secure connection [S5L)

Server Timeouts

Shot —F———— Long 1 minute

Sending

p LEENE a copy of MEessades on Server I

v Bemave from server after |5 3: day(s]

QK I Cancel I Apply

Select the Leave a copy of messages on server item as described above.

Here is an explanation on how you can leave a copy of messages on mail server on your
device. Select Options on the Tools menu, click the Messages tab and select the Keep

copy of sent mail in Sent folder check box.

Tx 4% 5:11 @

Options

When replying, include body

Indent
|:| Add leading character: = |
|:| Keep copy of sent mail in Sent folder

After deleting a message

|5h|:|w next message v|

Empty deleted items:
|Mar‘|ually' v|

Services | Message | Address | Storage |

E|“
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To download the attachments of message

You can download the attachments of message through directly connecting to mail
server using the CDMA module.

Tap the Connect (:g) icon to directly connect to the mail server.

Then you will find the connect B icon on the navigation bar.

Tap the connect B4 icon on the navigation bar to finish this connection.

Tap and hold the message to download the attachments and select Mark for Download
on the pop-up menu.

Tx 4% 351 €3
Inbox ~ Received Date ~
& Shockwavwe, com 741 A 0K |a
Zatch the hit series featuring Wallace,.. [—
& HEH 2jzzi03 oK |—
Mews Fram the American Anki-Aaging Sa. .,
& Placeiw'are 2121103 T —
Award-winning sales toaol, Mo cost krial,
@- gschung 2lz0fo3 2139k,
Fit': RRL Certification For CYBERBAME
A vakim 19003 26l
Mark as Unread
Move To... EI603 .
h & have aw...
Mark For Download 17(03 K
repl Ule For Prekest, .,
eply 117003
Reply All
Forward
Delete
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To download messages of your local folder through

ActiveSync

You can download the attachments of message through directly connecting to mail

server using the CDMA module.

Select the Options button on the ActiveSync toolbar and select the Rules tab as below.

Syhic Dptionsl Schedule Rules |

Canflict Resolution

4%'} If there iz a conflict (an item haz been changed on both

the mobile device and desktop computer or server):

Desktop: I Leave the item unresolved j

Sepver IAIways replace the item on my device j

File Conversion

D' Set how files will be converted when they are copied, moved,

1. or synchronized between this computer and your mobile

device.
Conversion Settings... |

Pazz Through

To uge pass through, this computer must be connected.

LConnection: |ENE =S

¥ Open ActiveSync when my mobile device connects.

0K I Cancel |

Select the Internet on the connection of the Pass Through item to download messages

of your local folder through ActiveSync. However, when you need to download your mail

messages on your desktop PC, you have to select the Work.

User’s Manual

5-22



Chapter 6
Configuring Device

This chapter details ways you can optimize your device using the Settings, and
describes ways you can expand features and functionality by adding programs. This
chapter also offers important tips on safeguarding your data by managing power and
memory.

- Adjust Settings
- Managing Memory
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Adjust Settings

On the Start menu, tap Settings that is composed of 3 tabs: Personal, System, and
Connections.

1. the Personal tab
Tap the Buttons ( E ) icon to assign functions to the 4 buttons located on the bottom of
your device. You can assign some functions to the hardware buttons using this setting.

i3 |settings Tx 4% 337 (D

Buttons

Aszign wour Favarite programs ko the program
hardware butbons,

Assignrment
Tazks
ElButton 2 Calendar

First, select a button among the 5 buttons

° and select a function you want for that
Button 3 Record button on the Button assignment.
F=leutton 4 Contacts
%, Button 5 Mobie Phone
Button assignment:
|TE|5kS v|

Select the Restore Defaults button to go
back to the factory defaults provided when
you purchase this device.

| Restore Defaultg—l»i

Program Buttons | Ip)Dowen Control |

E|“

l.ﬁ;“ Settings Tx £ 3:48 @

Buttons

Customize the way vour Up/Down control

repeats,
Delay before first repeat:
Move the slide to adjust the delay before
|I| =U IE first repeat.
Shurt 1 1 1 1 1 1 1 1 1 1 1 L|:||'|g

Repeat rate:
|I| . I , Ei Move the slide to adjust the repeat rate.

Sl Fast

Pragram Buttons | Up/Dawn Conkral |

E|‘
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Tap the Input (@% ) icon to adjust a setting on the Input Panel .

L% settings Tx 4% 343 (D

f
’
LE)

Input

| Select the default mode among Block
Recognizer, keyboard, Letter Recognizer

() Large keys e r[t] and Transcriber.
() small keys [d[f[g]

|:| Use gestures For the following keys and
remove them From the keyboard

E.;Space Ii—l Shift + ke
#E' Backspace |I_| Enter

Input Method | ‘ord Completion ‘ Cptions |

Input method:

If stwlus taps become inaccurate, align the
touch screen.

E|‘

Tx ™% 3:46 @

Input

Suggested words pop-up in a window abowe
the input panel. Tap to accept.

Suggest words when entering kext
Suggest after entering letteris)

Suggest ward(s)
&dd a space after suggested word

Input Method | Word Completion | Options

If stwlus baps become inaccurate, align the
touch screen.

E|A

Tx 4342 (D

Input

These options apply when writing or
recarding is supported.

YWoice recording Format:

| Itis recommended that you select the

11,025 Hz, 8 Bit, Mono (11 KBfs) . >
: : DAL : default mode of voice recording format to
Default zoom level for writing: 200% - conserve your memory size.
Default zoom lewvel For byping: 100% -

Capitalize first lekter of sentence
Scroll upon reaching the last line

Input Method ‘ ‘ord Completion | Cptions

If stylus taps become inaccurate, align the
touch screen.

E|A
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Tap the Menu (m ) icon to adjust the programs listed on the Start menu and New

menu.

:{1} Settings

T % 3:57 @

Menus

Checked items appear in the Start menu.
Others appear in Programs,

W] ActiveSync -
[ calculator
V= Calendar

Select items appear in the Start

[»]F=] Contacts
[ ]92File Explorer
(G Gamnes

1) Solitaire
[w]i= It
) Infrared Receive
[w]@& Internat Explorer -

Skart Menu | [ews Menu |

.j_a‘:.j' Setting=

Tx =% 3:59 @

Menus

|:| Turn on Mew button menu

Checked items appear in the Mew button
menu,

Appointrnent

Contact

E-mail Message

Excel workbook

Mote

Task

word Document

Skart Menu | Mew Menu |

menu. Otherwise, the rest appear in
Programs.

Select the Turn on New button menu
item to have the selected items
displayed on the New menu list.
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Tap the Owner Information ( ) icon to enter your personal information.

i3 |settings Tx 4% 403 (D

Owner Information

Mame:

Company:

Address;

Telephone;

E-rnail;

Shaw infarmation when Select this option box to show this
|:| R T Rl L I information when device is turned on.

Identification | Mokes |

E|“

£ |settings Tx 4% 408 (D

Owner Information

Mokes: |

Shaw inFarmakion when Select this option box to show this
I:‘ device is furned on * information when device is turned on.

Identification | N-:utes|
12312 [3[4[5|6]|7(8[9|0]-[=[«

Tabjq|wle|r|t[y[ulifo[p|[]]
CAPla|s|d[flg[h[j[k[I[:]"]
shift|z [x [c[v[b[nfm[,|.|/]+
ctlaiil - [1] [L]t]<]>
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Tap the Password (‘fﬁ ) icon to change a password.

F¥|Settings Tx 4% 4:10

Password

@ Mo password

O Simple 4 digit passward
D Strong alphanumeric password———————————|
Prompt if device unused

Password: |

When you select the Strong
alphanumeric password item, you
have to enter the 7-digit password: a
combination of the English upper
case, lower case letters.
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Tap the Sounds & Notifications (@ ) icon to adjust sounds that is enabled for events,
programs, screen taps and hardware buttons.

i3 |settings Tx 4% 4:26 (D

Sounds & Motifications

System volume
Silent Q 1 Loud

Enable sounds for
Events {warnings, swstem events)
Programs
Motifications {alarms, reminders)
Screen baps
O Soft @ Loud
Hardware butkons

() Soft (@) Loud

Vaolurne | Matifications |

l.{{;;r f|settings

Sounds & Motifications

1. Select an event _
According to each event, select the
corresponding sounds or

2, Select how to be notified notifications.

Play sound
[»] (=]

[ ] Display message on screen

[[] Flash light for

Maolume | Motifications
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Tap the Today ( % ) icon to use an image file as the background and select programs
that appear on the Today screen.

i3 |settings Tx 4% 432 (D

Today

To customize the Today screen, tap one of
the Following themes and tap Ok,

Elis=
Fire

Beam || Delete |

|:| IJ=e this picture as the background

Browse

Appearance | Ikems |

E|“

._a‘:;' Settings Tx 4% 4:33 @
Today
Checked items appear on the Today screen,
Calerndar
Inbos Select items listed to show them on
Tasks g the Today screen.

Display Today screen if dewice is not used

Far hiours

Appearance | Ikems |
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2. the Systemtab_
Tap the About ( ) icon to adjust the About screen.

¥ | settings Tx 4¢ 436 (D

L

About

Microsoft®E Pocket PC

Wersion 3.0.11171 (Build 11178}

1996 - 2001 Microsoft Corporation.,
All rights reserved.

This computer program is protected by
1.5, and international copyright laws,

Processar: InteldRY PXAZSO
£3.33 MB

Expansion slot: 1ot 5 use
Cwner:

Versian | Device ID | Copyrights |

E|A

Tx 4¢ 437 D

‘our device uses this information to identify
itself o okher computers, Enter a name that
skarts with a letter and contains the
characters _, A-Z, or 0-9

While synchronizing, this will be
Device name: [Pocket_PC * used for identifying itself and

| establishing a partnership.

Description: |

Version | Device ID | Copyrights |

£33 |settings Tx 4% 4:38 ()

About

Portions of this software are based on MCSA | o
Mosaic, NCSA Mosaic(TM) was developed by
the Mational Center For Supercomputing
Applications at the University of Tlinois at
Urbana-Champaign. Distributed under a
licensing agreement with Spyglass, Inc,

Contains security software licensed from RSA
Data Security, Inc,

Portions of this software are based in part on
the work of the Independent JPEG Group,

Cther product and company names mentioned

herein may be the trademarks of their
respeckive awners,

Wersion | Device [0 Copyrights|

4]

E|‘
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Tap the Backlight ( E}) icon to adjust the backlight.

Tx 4442 (D

Backlight

Warning: Using backlight while on battery
power will subskanktially reduce batter life,

% On battery power

Turn on backlight, when a button is
pressed or the screen is tapped

Battey Power ‘ External Power l Brightness I

Adjust power settings bo conserve power

E|A

(¥ |settings Tx 4% 442
Backlight

T‘@; On external power
Turn off backlight. if : -
D device is not used For

Turn on backlight, when a button is
pressed or the screen is tapped

Battey Power | External Power | Brightness

Adjust power settings to conserve power

=)~

[F |Settings Tx €443

Backlight

« Brightness

Battey Power I External Power ‘ Brightness ’V

Adjust powet settings to conserve power

Turn off backlight, if
device is not used For A sec hd

E|L

It is recommended to conserve your
battery life that you turn off backlight
if device is not used for the time you
select here.
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Tap the Clock ( ) icon to adjust the current time and alarm.

._a‘:;' Settings Tx £ 4:51 @
Clock
(# Home
N VI GMT+9 SeoLl =o———— Select the right one according to where
g g =, you stay.
9 3 415146 PM ||+
N N 2 f17f2003 -
S
() visiting
C C GMT+1 Paris,Madrid -
. 3:50:46 &M |a|+
* * 2 Ji7reo0s A
Tirne | Alarms |
8

£13 |settings Tx d¢4:52 (D
|:| < Descripkion = g
sET W TFS £:00 &M
|:| < Description = s
sET W TFS £:00 &M
|:| = Description = g
sETwWTFS £:00 &M
|:| < Description = e
sElTwTFS £:00 AM

Time | Alarms |

Edit E|A
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Tap the Memory ( % ) icon to adjust the allocation of memory temporarily.

£33 |settings Tx 4¢ 4:56 (I

Memory

Memory is managed automatically, To
temporarily adjust the allocation of storage
and progrann memory, mave the shider,

Total main memory: £3.32 MB
Storage Program
[ —————— ]

® ' ' ' ' ' ' [ [

Allocated: 31.70 MB  allocated: 31.63 MB
Inuse: 073 MB Inuse: 9,41 MB
Free: 30.97 MB Free: 22.22 MB

IMain | Storage Card | Running Programs |

Bemove programs to free storage memory,

Eind large files using storage memory,

E|"

3 |settings Tx 4¢ 457 (b

Memory

Total starage card memory: 28,27 MB

Inuse: 4,61 MB Free: 23.66 MB

] |

|File Store v|

Main | Storage Card | Running Programs ‘

Bemove programs to free storage memory,

Eind large files using storage memaory,

E|*
Tx < 4:58 @
Menmory
Running Program Lisk:
Marme |
ActiveSync
Inbox
- To conserve the program memory, you can
| Activate | | Stop | | Stop Alle stop programs that are not used from.
Main | Storage Card | Running Frograms
Eemove programs to free storage memary,
Eind large files using storage memary,
E|‘
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Tap the Power ({% ) icon to see the status of battery.

l.ﬁ;“ Settings Tx £ 5:02 @

Power

While being seated on cradle, if main battery
is not fully charged, it will move from 0 to
Main battery:  LiPolymer 100% on the charging bar

Battery power remaining:

o (| |10 ¢ Display the status of main battery.

Backup battery

o [

On battery power:

Turn off device if naok
Lsed for S minutes

On external power:

D Turn off device if nok
used For

Adjust backlight settings to conserve power,
|-

Display the status of backup battery.

Because the data and files you save on your device are stored in RAM, maintaining a
continuous power supply at all times is extremely important. If your device runs out of
power, all information stored in RAM is lost. Although Microsoft Windows for Pocket PC
and the preinstalled programs will not be erased, any information you have entered,
programs you have added, and customized settings are erased if you lose power.
Data stored in the File Store folder(NAND Flash) or on a SD card will be saved, even if
your device loses power. To protect your data, use the pocket backup application or
Microsoft ActiveSync Backup to back up regularly to the File Store folder(NAND Flash)
or to a SD card.

How long you can operate your device without recharging the battery depends on the
features and functions you use most.

Some functions, such as listening to music or using SD cards, use considerable
power and may reduce this time significantly.

When your device displays a dialog box warning of low power, you should respond as
soon as possible by recharging the battery. If you continue to use your device until
power reaches a critical low condition, a “Battery very low” message appears, and the
device shuts down automatically. You will be unable to use your device until you connect
to external power for charging.

Because the battery is charged automatically whenever your device is connected to ac
power, simply connect the AC power adapter or put your device on the USB cradle to
recharge it when the power is low.

While your device is connected to AC power, the charging status LED indicates
as follows :
" Red : charging(not fully charged), Blue : fully charged.
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Power Tips

® Follow these tips to ensure the longest use of your device between charges:

B Turn off the display manually.
If you are playing music or using other functions that do not require the display, turn
off the display by pressing and holding the power button. (Turn on the display by
pressing and holding the power button again.)

B Turn off sounds.
Use the settings to mute the speaker, or use the Sounds & Notifications settings to
turn off all but the most necessary system sounds.

B  Avoid using SD card while on battery power.
Most SD cards use considerable power and will quickly drain your battery.

Tap the Regional Settings ( g ) icon to adjust the time, number, especially period,
money and data type.

Tx <537

Select where you stay.

Appearance samples

Time: 5:30:49 PM

Shiort date: 2703

Lang date: Monday, February 17,
2003

Positive numbers: 123,456, 789,00
Megative numbers:  -123,456,759.00
Pasitive currency: ($123,456,759.00)
Meqgative currency:  $123,456,759.00

Region ‘ Mumber ‘ Currency | Tirne ‘ Dake ‘

E|A

{13 |settings Tx 4538 (O

Regional Settings

Time sample: 5:37:57 PM

Time style: h:rnmess tt Select the type of time display.
Tire separator: I:l

AM symbol: LM -

PM svmbol: P -

Region | Murnber ‘ CUFrency ‘ Tirme ‘ Dake |

E|A
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Tx =% 5:38 @

Sektings

Regional Settings

Short date: 2117103

Long date: Monday, February 17, 2003
Short date:

Date separator: |J|' v|
Long date:  [dddd, MMMM dd, yyyy +|
Calendar bype: |Greg|:|rian Calendar v|

Reqgion | Mumber | CUrrency | Tirve: | Date |

E|‘

Select the type of date display.

Tap the Remove Programs ( ) icon to remove the programs that are installed on

your device from the storage memory.

Tx 4% 5:43 (D

._a‘:;' Settings

Remove Programs

Programs in skarage memary:

When the storage memory is
short, remove the program

Remove

Tokal skorage memory available: 1708k

Adjust memary allocation,

E|‘

installed on your device.
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Tap the Screen (E\ ) icon to adjust the touch screen if your device is not responding

accurately to screen taps.

[£iF | settings Tx 4% 5:45 (O

Screen

Align Screen

Adjust the touch screen iF your device is nok
responding accurately to screen baps, To do so,
tap the Align Screen button or press the Ackion
hardware button,

Align Screen

ClearType

ClearType smookhes the edges of screen fontks
for many programs,

[ ] Enable ClearType

Mote: You must soft reset your device For
changes to take effect

Adjust input opkions to improve speed and
accuracy,

E|‘

This is easy way how to align screen during using other programs.

Press down the up button of the up/down control and press the power button to
have the Align Screen displayed and press the Enter button to begin the action of

aligning screen.

Tap the Screen ( @ ) icon to launch the corresponding program when you press the

hot key on the sleep mode.

l.ﬁ;“ Settings Tx =% 5:57 @
Wake up

Select the checkboyx to launch the
corresponding programs when wvou press
the hot key on the sleep mode.

|:| Launch Pragrams on Sleep Mode
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3. the Connections tab
Tap the AvantGo Connect (

browse the Internet offline.

icj Settings

Tx % 6:03 @

AvantGo Connect

Server settings

Avankiza, com (sync,avankga, com: 800

| add., .. ||F‘r|:||:|erties... | | Synic all

Remove. ..

.f:;' Settings

Tx 4% 6:04 ()

AvantGo Connect : Server

Server address

Hostname: |sync.avantgu.cnm |

Your account

Usernanme: | |

| Set password, ., |

Connection options

1 L L
12312 [3[4[5|6]|7(8[9|0]-[=[«

Tabjgjwle[r|t]y[ulifo[p|I

CaPlals[d[f[a[n]if[k[I[;]"
shift] z [x [c [v[b[n[m],
ctlaii] “ T\ ] |

—

1 7 ) icon to set the options for AvantGo that allows you to

You can add or delete Website displayed
on the list and also set the options for
each Web site.

Chapter 6 Configuring Device | 6-17



Tap the Beam ( @ ) icon to adjust the beam settings of your device .

£ |settings Tx 4% 6:06 (I

Beam settings

Receiving

Receive al incoming beamns and
select discaverable made

E|‘

Tap the Connections ( agg ) icon to set the options for a modem connection .

i3 |settings Tx 4% 6:08 (D

Connections

Irrt When needed, automatically connect
:l

ko The Inkernet using these settings:

ternet Settings hd

Modify... || Connect |

When needed, automatically connect
ko Work using these settings:

|W|:|rk Settifigs v|

| Modify... || Conneck |

Eg My mebwork card connecks ko;
|W|:|rk v|

Conneckions | Dialing Locations |

E|“
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l.ﬁ;“ Settings Tx £ 6:09 @

Connections

Location: |HI:IIT|E v|

| Mewr... || Remove |

Local Settings

frea code: () Tone dialing
Country code: D Pulse dialing
[ ] Disable call waiting; dial |:|

| Dialing Patterns... |

Conneckions | Dialing Locations |

E|‘

Tap the Network Adapters ( iﬂ ) icon to change the settings for network adapters .

Tx % 6:13 @

Metwork Adapters

Adapters installed: To change the options of a network driver,
! AN Adapter select the driver first and tap the
ME2000 Cormpatible Ethernet Driver Properties button. The drivers on the list

PPTP1 MOISW AN Adapter are installed as defaults, and you can
install the corresponding drivers that come

with an adapter that you purchase.

Adapters, such as wireless nekbwork,
(Ethernet) cards, connect vour mobile device
ko a nebwork,

| Propetties |

E|‘

Chapter 6 Configuring Device | 6-19



Managing Memory

Your device uses three kinds of memory: 64 MB of ROM, 64MB of storage and program
memory (RAM), and optional SD memory cards.

Storage and Program Memory (64MB of RAM)

The volatile RAM memory on your device is allocated between storage memory and
program memory. The operating system automatically manages the allocation between
storage and program memory; however, in some situations—such as when memory is
low—it may not be able to adjust the memory properly. Maybe you will find a little short
memory because of the bad sectors among 64MB of RAM.

If you receive a message stating that storage or program memory is unavailable, try the

following solutions.

® To increase storage memory, you can

B Move files or programs into the File Store(NAND Flash).

B Buy an optional SD extended memory card, and move files from internal memory to
the card.

B Remove Web pages stored for viewing offline in Internet Explorer folders.

® To increase program memory, you can

B Use Task Manager or the Memory settings to stop programs you are not currently
using. In most cases, programs automatically stop to free needed memory. However,
in some situations, such as when a dialog box is waiting for a response, the program
may not be able to stop automatically.

B Remove your device from the cradle, remove the SD card (if inserted), and reset your device.

ROM(32MB NAND Flash out of 64MB)

This uses nonvolatile memory; that is, it will not be erased if your device loses power. In
other words, ROM is composed of 32MB NOR memory and 32MB File Store(NAND
Flash). The system codes and applications, including Inbox, Tasks, Calendar and
Contacts, etc., are installed on the NOR memory so that you cannot erase or install
those applications. However, the phone program is installed on the File Store(NAND
Flash) and you can use the rest memory of the File Store(NAND Flash) to store your
most important files or as a location for your backup file.

However, when you erase the Cyberbank and CallNotes folder of the File Store memory,
you have to upgrade your device. Maybe you will find memory that is less than 32MB of
File Store because some memory is used on system.

The File Store appears under the My Device folder of your device. Files stored in

the File Store are not included when you back up your files using ActiveSync or
the pocket backup application.

User’s Manual | 6-20



The File Store is non-volatile memory so that it will not be erased after
performing hard-resetting. However, when you mistakenly erase the sub-folder
of your File Store folder where the some programs are installed from your
Companion CD, you have to re-install them from Companion CD.

For more information on backing up your device to the File Store(NAND Flash), see
“Backing Up and Restoring Data” in chapter 4.

SD Memory Cards

SD memory cards are small, removable flash storage cards that enable you to expand
the memory of your device. You can use SD memory cards for backup storage, archives,
or to transfer large files to other devices. SD cards can be purchased from a variety of
third-party vendors.
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Chapter 7
Using the Mobile Phone

Your device has a built-in CDMA module that supports wide-range data communication
and additional features including SMS (Short Message Services), along with voice calls.
These features save you the trouble of having to purchase another cellular phone with a
phone number. Remember that you have no other right to copy the ESN number against
the communication law.

® This chapter includes information on:
B Phone Program
B SMS : Short Message Service
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Phone Program

This phone program enables you to place a call.
Use the dial pad to enter the phone number and tap the Send button.

. You can communicate with other persons through the speaker and microphone
and the optional earphone that should be inserted into earphone jack.

The Phone display

] Short Message Service
4/3 [Tue]

[POZ ] — Note

Call

M— Send button

; E— Clear button
# T E— End button

= 2 =
Contacts ’ Display Own Number and Version

Recently Dialed Phone display

o || o] [

Settings

Indicators in the Phone display

Indicators | Description Indicators | Description

(Tl Signal Intensity E Vibrate mode

Service area E 1x network

E Not in service area E 95A network

E Lock E Roaming
[}

Voice message or SMS

Battery charging status
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Using the NOTE button

Here is how we can use the NOTE button during a voice call.
When you need to make a note during a voice call, tap the NOTE button to open the note program that is
provided on your phone program. You can enter any contents you want and record your voice.

utes Tall % 2:15 @

©) This is a note
for outgoing call.
Number : M
019-214-1225
Name : *Veryme
Date/Time :

2003/03/03 -
@ ||y | |« |m |t
Mew Edit Tools |é| El‘

When you finish entering any contents you want, tap the button to display the folder(File
Store\CallNotes).

Til €€ 216 €3
[=CallMotes ~ Name -
[go192141225-030... 2:15p 37k

[0234834639-030.. 11:04a  716b

Mew Tools El*
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Using the CALL button

Tap the Call button to display a list of recently incoming, outgoing and missed calls,
including caller information and call time since initializing your phone.

Mobilephone Tall 4% 11:39 @
%S' Cut % Tn E Missad e Tap to save to Contacts

; 03-03 01:28 PM  023-433-4654
Haryme

HE

023-433-4654

Outgoing call
023-453-4654

023-483-4654

Call waiting

023-453-4654

Three-way calling

023-483-4654 | |

| === RN Call Time

El‘

Missed call

Select the item that is displayed as No Name and tap the Save button to save a corresponding name.

Mobilephone Tall 4% 1:20 @

rMHarne

tast | JAst[ ]
Display | E|

-Phone Murnber
Type |MDbiIe Tel E|

Mumbet (023-493-4654

123(1(2[3[4]s]e|7[8[0]0]- =
Tabja[wle|r[t[y|ulifo[p|[]
caPla[s[d[f]a[n[i[k[1[:]"
shift| z [x [c[v[b[n|m[,[.[/] &
ctfai] - [\ ] [L]r]«]~=

(4 || Canicel

=]

Add the corresponding name for it and tap OK.
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Using the SEND button

You can make a call as follows :

® Enter phone number and tap the SEND button to make a call.

® When you tap the SEND button shortly once, the number you last called
appears on the screen and if you tap this button once more, you are connected
to this number.

® You can use the up/down control to have the recently dialed numbers displayed.
When you press the up button or down button of the up/down control, the
number you last called appears on the screen. If you press the Enter button,
you are connected to this number.

Using the CLEAR button

If a mistake is made while dialing, tap the Clear button to clear the last digit, or tap and
hold the Clear button to clear all the digits.

Using the END button

Tap the END button to end a call.

Tap and hold the END button for a little longer (2 or 3 seconds) to turn the CDMA

module off so that you cannot make a call, send SMS messages and browse the Internet.
Tap and hold the END button again for a little longer (2 or 3 seconds) to turn the CDMA
module on.

You can not make a call, browse the Internet and send SMS messages while the
CDMA module is not on.

Using the Vibrate mode

Tap and hold the Eicon on the dial pad to turn the Vibrate mode on. Then you will be
able to feel vibrating on your device and also see the Eicon on the Phone status pane.
On this Vibrate mode, you will feel the vibration on your device when a call is coming.

Using the Lock button

Tap and hold the aicon on the dial pad to turn the Lock mode on. Then you will be
able to see the Eicon on the Phone status pane. You cannot make any calls on the
Lock mode. When you want to get out of the Lock mode temporarily, enter the password
on your dial pad. Turn your phone program off and on to go back to the Lock mode. If
you want to get out of the Lock mode permanently (in stead of temporarily), tap and hold
the Lock button to have the password screen displayed. Then enter the password that is
set as “0000".
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Placing a call

You can place a call as follows :

Use the dial pad to enter the phone number, including the area code and tap

the Send button.

When you want to use the Contacts to place a call, tap the Contacts icon on the

Command bar.

Muobilephone Tx 4% 11:58 @

Address Diial

By Mame |~ ||59aru:h|
Marme Murnber | Type | -
&P Grace ... Ete. |
H1hsan ... Etc.

& Irmran ... Etc.

¥ Jazon ... Etc.

& Jennif,.. Etc.

& loe Park Etc.
Q"Kil‘l‘lJ Swo 02-3423-0000 Wor,,,

& Peter ... Etc. |

[ Steph. . Etr. h
ab ||:|:I " ef |gh| ii | ki "mnll:uplqr |
st |uv "wxlyz | # | & " 1 | Close |

E|A

Select a phone number you want and tap the Dial button on the upper-right

corner. You will see only one phone number for each person at this screen. If

you want to place a call with another phone number, double-tap the

corresponding contact to display the screen as below:

Mobilephone Tx =% 2:33 @

| Rirng |

- | Ricture |

02-577-0000 |

| 02-3483-0000 |

ThdESF

E|‘

Tap a phone number you want to place a call automatically.
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Use speed dial numbers to place a call as follows:

v' One-digit number (0 ~ 9): Tap and hold (about 2 seconds) the
corresponding speed dial number.

v Two-digit number (10 ~ 99): tap the first digit of the speed dial number,
and then tap and hold the second digit of the speed dial number.

v' Or tap the corresponding speed dial and tap the Send button.

If you don’t remember the corresponding speed dial, tap the Settings icon on
the Command bar > the User button and select the Speed dial icon.

'| Mobilephone Tl 4% 11:11 @

Mo I Marmne | Murnber

Select the speed dial you want and tap the Dial button.
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To receive a call

When the incoming call is alerted with a flashing indicator and an audible sound or a
vibrating alert with the screen displayed as follows:

Tall % 1:18 G
..,‘\ -

Marne
*Yeryme

Caller 1D
r 023-483-4654

- Called ID

AMNSWER

‘ MUTE H IGMORE

E|A

Tap the ANSWER button to receive this call, or tap the MUTE button when you don't
want to hear the bell sound (but the caller can still hear the outgoing bell sound) or tap
the IGNORE button to disconnect the call without answer.

While communicating through your phone module, you will also see icons on the Command bar as follows:

Descriptions

Tap one icon to have the other icon displayed.
You can un-mute while communicating.

" Tap icon to have the other icon displayed.
Key Sound

You cannot hear any key sound while tapping any key on your dial

fliRemove Key Sound
pad.

g , Tap this icon to have the User Information screen displayed and you
User Information
can select any number you have entered before to send out.
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Make a speed dial using Contacts
Tap the Contacts icon on the Command bar.

.fw}' Mobilephone Tx 4£ 11:58 @

Address Dial

By Mame |~ || ||59aru:h|
Marme Murnber |Tﬁme I-

& Grace ... S

#1hzan ... Etc.

&Irmran ... Etc.

¥ Jazon ... Etc.

& Jennif... Etc.

& Joe Park Etc.
Q‘:Kil'l'lJ Sw 02-3433-0000 wWor,.,

& Peter .. Etc. |

&P Steph... Etr. T
ab ||:|:I " ef |gh| ii | ki ||rnr‘|||:|p|qr |
st |uv "wxlyz | # | & || 1 | Close |

El‘

Double-tap a contact you want to make a speed dial for.

Mobilephone Tx 4= 2:33 @

kirn, Swe
. SpeedDial |
Tap to assign a specific bell sound to the
| Ring ° 1 specific person.
- | Picture |
| 02-577-0000 |

| 02-3493-0000 |

ThddESP

ElA

Tap the Speed dial button.
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f| Mobilephone Tx ¢ 2:35 @

Tap the arrow to select a phone number

Name K, S that is saved for the specific person and
Humber to add || enter the speed dial number and tap the
speed Number I:I Add button.

[lu} | Marme | Type | MLkt -

0

1

2 =

2

4

3 —

&

7 I+

+1 Z [ [» If you have too many speed dial
(00| 1020 30|40 cose | numbers, you can use these buttons as
50| 60| 70 |20 | 90| shortcut buttons.

|«

Tap the arrow to select a phone number that is saved for the specific person.

Mobilephone T 4% 2:36 @
MName Kirn, S
MNurnber to add B
Mohile Tel:

Speed Murmber car Tel:

Mo Marme  |Assist Tel:
Horme Tell: 02-577-0000
Horme Tel2:
Wark Tell: 02-3423-000)
Wiark Telz:

*

Sl LR R VR B O L VR R e

1 [ T

00 ] 10 (20|30 ][40 ]| coss |

s0 | e | 70 | 80 |l 90|

E|‘

Select the phone number you want and select speed dial number on the list as shown below.

Tx q€ 241 D

Harne Kirn, S
Nurmber to add |Home Tell: 02-577-00+]

Spieed Nurnber El

o Type | Murnber

1
2
£
4
]
]

|

-

4] 1] [ T
(oo | 10 (20 (30| 40| cese |
|50 |60 | 70 | 80| 90|

E|A

Tap the Add button to add this number to the Speed Dial list
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Add your picture to contact

Copy a picture (100*100 pixel, BMP file recommended) to a folder you want through

Microsoft ActiveSync.
Tap the Contacts icon on the Command bar.

."f:.‘i1 Mobilephone Tx % 11:58 @

Address Dial

By Mamme |+l ||SEar|:h|
Marme INumber |Tﬁme I“

& Grace ... Etc. [

8 Thsan ... Etr.

&Irmran ... EtC.

¥ Jazon ... Etc.

¥ Jennif,.. Etc.

¥ Joe Park Etc.
Q‘:KirﬂJ Swy 02-3433-0000 War,..

P Pater .., Etc. |

¥ steph... Etc. h
ah ||:d " ef |gh| i | ki ||n'|r'|||:|r:|||:|r |
st |uv "wxlﬁ;z | # | & || 1 | Close |

ElA

Double-tap a contact you want.

Mobilephone Tx 4% 2:33 (0

| Ring |

- | PFicture |

| 02-577-0000 |

| 02-3483-0000 |

YL

E|A

Tap the Picture button.
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Mobilephone Tx 4% 2:49 @

Folder : |1|*-13r Documents |

Type : |bmr:| {*.brmp) v|| Cancel |
[] Show the hidden(files)
Marmne | Size |
[ Business Dir  2001-
= Personal Dir  2001-
= Ternplates Dir 2001-
1 I [ »
|~

Select the folder you want and tap the picture.

Call Waiting

When you are on the phone and another call is received, you hear a call waiting tone
and you will have the next screen on the display.

Tap OK to enter a numeric digit on the
main screen of phone program.
However, you are still on the Call Waiting
mode.

On the main screen of the phone
program, you can try as follows :

Press the 1 button and the Send button
to disconnect the original caller and
switch to another caller.

Press the 2 button and the Send button
to switch to another caller.

Press the 3 button and the Send button
to move to the conference call mode.

011-9620-4943 011-3016-7500

Current Off
Waiting Call On

Select any person you want to communicate.
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Using the Settings button

Tap the Settings (E) icon to adjust the settings on the phone program. Tap the User
Settings button to display the User Settings screen.

Lock ng Setting

Vaoicernal — Call Forward

<., |
Ear-Set Data Select MAM

ComnrmLric, .. Edit User Recent

Info Ctgoing Call

Phione Password  Auto answer b

Initialization Speed Dial Cunver‘uer‘u:e Dual Phone
Murmbers
Ly
DTMF Tone Change SKIM Woice Privacy
| conral | user | | Close |
|~ |~
User Settings

Control Panel Settings

Tap the Lock (SI) icon to adjust the settings on restricting calls including the

international call, Call Log and SMS.

Ll 4% 10:49

ALto Lock
() Enable (%) Disable

-Restrict Calls

|| International

D call Log o | This _enabl_es you t_o restrict these
functions: international call, call log,

SMS.
| | smMs

| Ik, || Cancel |
|
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Tap the Ring Setting (@-'—) icon to display the sound screen.

Melody Play || Search
|HFiIe Store', CyberBankiMobilePhone\ S0
Connected Play || Search
|HFiIe Store CyberBank\MokilePhone! So
- Select the bell sound or adjust the
Disconnected Play Sear':f' volume. Also you can download the
|"|,Fi|E StorelCyberBankMobilePhone! 5o bell ac?d install it for your favorite bell
souna.
Message Play || Search

|1File Store' CyberBankiMobilePhone)So |
1

Ring Yalurne 'I . L

-Alert me when an SMS mmessage arrives o

(%) Once

Select the option of how your device

O Every 2 rnutes I let you know that SMS arrives.
) Mo Sound
|C'K ___________ || Cancel |
=~
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Tap the Ear-Set (r%) icon to adjust the setting on headphone.

Mobilephone Tall 4% 10:52 @

pe TN

When you select "Enable”, with wour
Ear-Set inserted, you can listen to
phione and SMS bell sound thraugh
not speaker, but only Ear-Set,

Setup Ear-5et
{ ) Enable (%) Disable

| ] 4 || Cancel |
B[

e

O

Tap the Data Communiation ( %) icon to adjust the setting on how you close the

connection to avoid unnecessary charging after using data communication.

Mobilephone Tl ™= 10:58 @

S -

- Data communications

{1 Unable to end autormatically

O End automatically when It is recommended that you set up

not wsed for 10 minutes the option to avoid unnecessary
] charging after using data

(%) End automatically when communication.
hiot used for 30 minutes
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Tap the Phone Initialization :‘:"

Mobilephone Tl 4% 11:01 @

Phione Mame, Auto Area Code,
Iser Info

) icon to initialize your phone program.

Ear Set, Data, vibrate Mode, Lock
SMS Alert, Dual Phone Murnbers

Select the items you want to
[ Call Log || sMs ® Initialize and tap the OK button.
|| Address Book || Emergency Cal
|| additional Services

| | Restricted Call || Sound

. sekctal | | oK |

| Clear Al | | Cancel |
=~

Tap the Password () icon to change your password.

f| Mobilephone Tall 4% 11:01 @

. . N v

Enter new password, )
As default, your password is “0000”,
ey |:| but when you want to change to
another number your want, use this
*— .
Canfirm |:| setting. And also be sure to
remember your new password.

Otherwise, you have to ask A/S
1 2 ‘ 3 ‘ 4 center to repair.
=] & ‘ Fi ‘ 2
9 0 £
| 2k || Cancel |
|~

Your password should be 4 digit number.
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B,

') icon to automatically answer an incoming call after a few

Tap the Auto Answer (
rings without any key press.

.fw.j‘ Mobilephone Taill 4% 11:01 @

AUtO answer
{1 Enable {#) Disable

E|A

Tap the DTMF Tone( =) icon to change the DTMF tone.

Mobilephone Tall 4% 11:02 @

m

Select Long DTMF when you want

DTMF Tone !
the key-pressing tone to sound long,
and select Short DTMF when you

( JLong OTMF (%) Shart DTME® | want the key-pressing tone to sound
short, regardless of how long you

press the key.
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Tap the Change SKIN

Muobilephone Tx 4% 12:06 @

Folder : |1Fi|e Storel,CyberBank! MokilePh |

) icon to change the skin.

Type |5KIN Files (*.ckn v|| Cancel |

[ ] Show the hidden files

Mame I Size |
First, save your skin to a folder you
e | want, then your phone program skin
will be displayed.
1] I [ »

El‘

Tap the Voice Privacy () icon to make Voice Privacy available during a call.

Mobilephone Tall 4% 11:02 @

m

Select a Woice Privacy

D Standard Tap Enhanced to make Voice
Privacy available during a call.
{#) Enhanced
ok | cancel |
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Tap the Voice mail (@') icon to adjust the settings of voice mail.

Tall = 11:03 @

First, ask your service provider of

how you register for this service and
tap the register button to register. To
Check Woicemail : | ° F hear the voice mail that arrived while

| Connect || Register ||Unregi5tered| you could not receive them, tap the
Connect button.

Murnbers for RegisterUnregistered —

Fegister ; Unregistered :
|*1234 | | |
Auta Connect . | | | Auto Connect |

Lo Jli iz f 3 )la] ]
L5 Jlellz]lellof ¢]

<- | Ik || Cancel |

El‘

Bl
&F) icon to adjust the settings of call forward.

Tap the Call Forward (

Enables you to reroute incoming

; . calls to a different phone number
Murnber for Call Forwarding-all the time g~ when it is registered. For information
on registration, ask your service

| | |Regi5ter || Unregistered | provider.

Murnbers for Register fUnregistered —
Register Unregistered
|*21* | [#21# |

Lo fladlafa(laf «]
s )ef 7|8 o]fc¢]
|r:|}< __________ || Cancel |

ElA
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Outgoing Murntber

_ o |

E|‘

Tap the Emergency Calls '%

Tal € 11:11 ¢
-

S
[ ]
arme | Murnber
Fire Station 190

Marne ¢ Murnber

123(1(2]3]4
|

|
Tablg[wle|r

ARHEEINAE
[tly|uli[o]p]|[

CaP[as[d[f[a[h[i[k[IT:]"

shift] 2 [x[c[v[b[n[m]

AN
ctjai] - [\ ] [L]1

Double-tap the number you want to
make a call to.

Select an item you want to delete
and tap the Delete button.

Be careful not to tap the Delete All
button mistakenly.

) icon to see emergency calls on the list.

Enables you to add, modify and
delete emergency numbers. Double-
tap a number you want to make a
call.
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Tap the Speed dial (/" ) icon to see a speed dial for the number you use frequently.

15| Mobilephone Tl % 11:11 (D

Ho | harne I Murnber
Select a speed dial added before for
o your convenience number to make a
call.
Dl | close |
E|*

Tall 4 11:11 €y

mL [ ]

Last Call |00:00:00 | Woice
Enables you to reset your past voice

Al Calls |EIEIEI:EIEI:EIEI | Woice lﬂ‘lﬁ calls and Internet.

|D00:00:00 [Internet | Reset
Total Calls | 0000:37:36

123}1[2[3[4]s[6[7[8]9]0]-[=]@
Tabla[wle[r[t]y[uli[o]p
capla[s[d[f[a[h[jlk[1];]"]
shift[z [x [c[v[b[n[m[,].]
ctjai] - [\ ] [4]1

o |_care |

—
e
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Tap the WMP Control L’ icon to adjust the settings of Windows Media Player.

.*'E?" Mobilephone Tall % 3:44 @

.

Q

Select "Stop" to stop Windows Media
Flayer when receiving a call.
Otherwise, select "Play" to hear your
kel sound and WYWindows Media Player
at the same time.

Media Player Status

(%) Stop 3 Play

| Ik || Cancel |
=~

Tap the Data Backup () icon to perform the data backup.
Tall 4% 11:13 @

Press the Ok button below to perform
the data backup

User’s Manual | 7-22



SMS(Short Message Service)

Contact your service provider before using this function.

Tap the SMS button on the phone program to display the SMS message screen. When
you receive a SMS message, appears on the phone status pane of the phone
program. When you tap this icon on the phone status pane of the phone program,
nothing happens and you have to tap the SMS button on the right side of the phone

program.
Tap to open the list of SMS Inbox.

__ Tap to open the list of SMS Outbox.

Tap to open the list of SMS Temporary folder.
E— p p porary

1 | Receive Time | Contents F

@ 03-02-18 13:03:56 [Mormal]teztc7
@ 03-02-17 17:09:12 [Mormal]Messa
@ 03-02-17 17:08:23 [Mormal]Messa
@ 03-02-17 17:07:09 [MNormal]Messa

-02- :06: £53
4 l L4

1

Tap to make a new SMS message.

Tap to reply to the selected message.

I |
| Menw f
Tap the Delete All button to delete all

® —— messages listed above. So be careful
not to delete all messages mistakenly.
|

Tap to save sender’s information on
your contacts.

Tap a message you want to open.
o X unread message
° @: Read message
o BB Duplicated message

During data communications(Internet), if SMS message is sent or received, the
Internet may be disconnected depending on the settings of your service provider.
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Add sender’'s phone number to your contacts

Tap the SMS button on the right side of the phone program.

Tx 4% 12:04 (D

1 | Receive Time | Contents
@ 03-02-18 13:03:56 [MNormal]teztc7
@ 03-02-17 17:09:12 [MNormal]Messa
@ 02-02-17 17:08:23 [Mormal]Mesza
i

b

02-02-17 17:07:09 [Mormal]Mesza

1

-02- ;06 £53
P Il 3

s

- MeEw

El‘

Among the SMS messages listed on the Inbox tab, if there are messages whose phone
number you want to add to your contacts, select the message and tap the Save Contacts
button to save the phone number to Contacts.

{| Mobilephone Tl 4% 1:20 @

last [ Rt ]
Diisplay | El

-Phone Nurnber
Type: Mobile Tel |~

Mumber [023-483-4654

|
12301[2[3]4[s][6[7[8]9]0]-[=]«
Tabjafwle|r[t[y|ulifo[p|[]]
caPlals[d[fla[h]ifk[1[;:]"]
shift| z [ [c[v[b[n[m|,[.[/] <
ctfai] - T\ ] [L]r]«]-
Ik || Canicel

=8

Enter any necessary information and tap OK.
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Reply to and Forward SMS

Among the messages listed on the Inbox, select a message you want to reply to.

Tx ¢ 12:04

- Inbox
1 I Receive Time | Contents -
@ 03-02-18 13:03:56 [Mormal]tezte Double-tap to forward this message.

] 03-02-17 17:09%:12 [Normal]Messa
] 03-02-17 17:08:23 [Normal]Messa
%] 03-02-17 17:07:09 [Normal]Messa

1

-2 HILH £53
4 IIl +

rs

I =11

E|A

Tap the Reply button

Mobilephone Tx £ 12:05 @

Contacts ||

[ »

0000000000 :Ii Tap to enter the call back.

Drm Savg Tap to temporarily save this message
to the temporary folder.

ﬁ

Irniatican
Setid

| | Resat

pu}
m
@
=

0/240 || Deliveryack
123(1[2[3]4][5]6[7[8]0][0]-[=[«
Tabla[wle[r[t]y[uli]o[p]I
caPlals|d|fla[h[j[k[I[;]"
shift[z[x [c[v[b[n[m[,[.]
ctlai] - [\ ] [L]1

Tap the Contacts button or tap the Enter Phone Number box to enter phone number you

want directly.

When you enter several phone numbers on the Enter Phone Number box, each
phone number should be separated by semicolon (;).

Enter messages on the text box and tap the Send button to send the message.
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Compose a new message

Tap the New button of each view. (Inbox, Outbox and Temp of SMS)
Muobilephone Tx £ 12:05 @

Contacts ||

[

orma-v|

i

Savg

0f240

123(1(2]3]4]|5]6|7[8[0|0]- =]«
Tablglwle|r[t[y[ufifo[p[[]]

caplafs[d[f[a[h[j[k[I]:]"

shitfz[x[c[¥[b[n[m], . !

.|
ctlai] - [\] [4]1

O0000ao0o0 .l Tap to enter the call back.

Tap to temporarily save this message
to the temporary folder.

Tap the Contacts button or tap the Enter Phone Number box to enter phone number you

want directly.

When you enter several phone numbers on the Enter Phone Number box, each

phone number should be separated by semicolon (;).

Enter messages on the text box and tap the Send button to send the message.

The length of a text message that you can send each time varies slightly from
each service provider, but it is mainly limited to approximately 80 characters for
English. Therefore, if the message you have created surpasses the limit, it will

be divided into 80 characters. The number of messages to be sent is

automatically displayed on the bottom part of the New window.
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Chapter 8
Microsoft Pocket Outiook

Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You
can use these programs individually or together. For example, e-mail addresses stored
in Contacts can be used to address e-mail messages in Inbox.

Using ActiveSync, you can synchronize information in Microsoft Outlook on your desktop
PC with information in Pocket Outlook on your device. Each time you synchronize,
ActiveSync compares the changes you made on your device and desktop PC and
updates both computers with the latest information. For information on using ActiveSync,
see ActiveSync Help on your desktop PC.

@ In this chapter, you will learn to
Schedule appointments and meetings using Calendar.

Keep track of friends and colleagues using Contacts.

— Keep a to-do list in Tasks.
Capture thoughts and ideas with Notes.

For details on using Inbox to send and receive e-mail messages, see “Sending and
Receiving E-mail” in chapter 5.
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Calendar : Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can
check your appointments in one of several views (Agenda, Day, Week, Month, and Year)
and easily switch views by using the View menu.

Ealendar T 4% 12:49 9
Feb 18,03 sMJwTFs B] « »  Taptogototoday.

check bank account
10:00a-10:30a

weekly
1:00p-1:30p

Year view

N::w Tools E E % 7 E|‘

‘ \— Day view
Tap to create a new
appointment. Week view
Agenda view Month view

You can customize the Calendar display (for example, change the first day of the week),
by tapping Options on the Tools menu.

f|Calendar Tx £ 12:51 @

Options

1st day of week: |SEg=ER

Week view: |5-day =t=Th -

[ ] show half hour slats
[ ] show week numbers
[[]Use large font
Set reminders far newr items
|15 v| |minute{5]| v|

Shovy icons: |ﬁ|{}||§|ﬁ{‘r|ﬁ—|ﬁ+7 X Reminder™ Recurs B Note
Location L Attendees"‘{3I Private

Send mesting :
requests via: |f-‘~EtWES?HE v|

E|‘
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To create an appointment

1. In Day or Week view, tap the desired date and time for the appointment.

2. Tap New.
l.%.}" Calendar Tx 4% 12:52 @
Subject: Tap to choose from predefined text.
Location: Yo Tap to choose from previously entered locations.
» 241803 12:00 P
Starts: 2/18/0 : ‘.—L Tap to return to the calendar (the
Ends: 2,-’]43,-"03 1:00 P appointment is saved automatically).

Tap to selectadate. — Type: Bormal

Oocurs: CNCe

Tap to select a time.

Reminder: Eemind me

15 minutes)

Cateqories: MO Categories...
appoinkment r-.j.;.l;.gsi The N_otes_ tab is a good place for maps
123|1|2|3 4|5|E|?|B|9|D|- :l* and directions.
Tab[g[wle[r[t[y[u|i[o[p[[]]
CaPlla[s|d[f[a|h[i[k]1];]"]
shift| z [ [ c[¥[b[n[m[ [ [/«
cafain] - [\ ] [4[t]<]~

Edit @j

3. Using the Input panel, tap first to select the field, and then enter a description and a

location.
4. If needed, tap the date and time to change them.
For example, select the date to have the calendar pane displayed as below.

Kl February 2003 W KB February oo

S MW T F 5 S M T W T F 5
26 27 29 30 31 1 26 27 28 29 30 31 1
2 3 5 6 7 B8 2 3 4 5 6 7 B
o 10 12 13 14 15 o 10 11 12 13 14 15
16 17 19 20 21 22 16 1?‘1‘5| 20 21 22
23 24 Xp 26 27 28 1 23 24 25 26 27 28 1
2 3 4 5 6 7 B 2 3 4 5 6 7 8B
Today: 2f18/03 Today: 2/18/03

A 4

January

* Febhruary

March

April

May

June

July

August

September

October

Movember

December

5. Enter other desired information. You will need to hide the Input panel to see all
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available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see “Notes: Capturing Thoughts and Ideas,”
later in this chapter.

7. Tap OK to return to Calendar.

If you select Remind me in an appointment, your device will remind you according to the

options set in the Sounds & Notifications control panel.

Using the Summary Screen

When you tap an appointment in Calendar, a summary screen is displayed. To change
the appointment, tap Edit.

weekly 1

1:00p-1:30p Tue, 2/ 18/2003

the conference hall at 12th floor

Edit Tools E|A
[}

Tap to change appointment.

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The
meeting notices will be created automatically and sent either when you synchronize
Inbox or when you connect to your e-mail server.

Indicate how you want meeting requests sent by tapping Tools and then Options.
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Calendar

Options

Tx ¢ 12:51 ¢

1st day of week:

Wik vienw:

S-day week

[ ] Show half hour slats
[ ] show week numbers
[[]Use large font

Set reminders for new itemns

|15 v| |minute(5]|

v|

Show icons: |g

G||§|ﬂl‘r|ﬁ'|ﬁ+7 X Reminder™ Recurs B Note

Send meesting

Location ¥ Attendees“531 Private

requests wia: |*'-’~Cti1"95'5fﬂ'2

v|

E|‘

If you send and receive e-mail messages through ActiveSync, select ActiveSync.

® To schedule a meeting
1. Create an appointment.

2. Inthe appointment details, hide the Input panel, and then tap Attendees.

f;" Calendar Tx 4% 1:16 @
Subiject: -

Location: i
Starts: 2/18/03 1Z:00PM ™
Ends: 2,/18/03 1:00 P b
Type: Mormal
Qccurs: DNCE

Reminder: Remind me

15 minutes)

Categories: MO Categories...

Attendees: Mo attendees...

Status: BuUsy

Sensikivity: Mormal

Appoinkrnent | MNotes |

Edit

E+‘7 Tap to show Input Panel.

3. From the list of e-mail addresses in Contacts, select the meeting attendees.
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Calendar Tae {2 1:31 @
[ ]ale Comm slecomm@pis... |a
[l Clintan billdlinton@ca... ||
[[]Casey Taxas taxas@west,., | |
[ ]Emily Kim emilykim@ca. ..
[]Esther Kim estherkim@e, .,
[]Grace Kim gracekim@ca, ..
[ ]Thsan Muse ihsanmuse@, .,
[ ]Imran Communicate imnran@cornm, ..
[]Jason Park jasonparki@e, ..
[ ] Jennifer Chai jenniferchoi...
[ ] 3o Park joepark@ca, ..
[ ]Kim, Sw swkimi@ch,co...
[]Peter Park. peterparkide, ..
[]5tephen Whitt stepherwhitt, ., [
[ 1Tim Eulks timbulks@we. .. |7

E|‘

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help

and Inbox Help on your device.
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Contacts: Tracking Friends and Colleagues

Contacts maintains a list of your friends and colleagues so that you can easily find the

information you are looking for, whether you are at home or on the road. Using the

infrared port of your device, you can quickly share Contacts information with users of

Pocket PCs and other mobile devices.

Select the category of contacts you want displayed in the list.

l.{f}jr‘«"‘ Contacks

All Contacts «

Ty 4% 1:34 9

Tap and enter part of a name to quickly
find it in the list.

#ab| cde| foh| ik [ Imn|opa] rst juw] sz

Ale Conm
Bill Clinton
Casey Taxas
Emily Kim
Esther Kim

Create Copy

Delete Contact

alecomm@piscel....e
billclinton@com... e
taxas@western.c...e
emilykim@comm...e
estherkim@con... e

Beam Contact...

Send E-mail to Contact...

Kinn, 5w

Peter Park
Stephen Whitt
Tim Bulks

02-3483-4651
peterparki@com...
stephenwhitt@c...

F 9
— Tap to display or edit the contact details.

Tap and hold to display a pop-up menu of
actions.

2
=
g
MM RMEMMMDMD

timbulks@weste...

N%w ¥iew Tools

2

Tap to create a new contact.

To change the way information is displayed in the list, tap Tools, and then tap Options.

Contacts Tx =% 1:38 @
Options
List view settings
Show ABC tabs
[ ] Show contact names arly

[[] Use large font

Country/Region settings

Area code:

Countryf” [njted States -
Region:
Edit E|a~
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To create a contact

1. Tap New.
contac i saved actomatcal.
Mame: ¥ |~
Tob title: H
Department: e[ Scroll to see more fields.
Campany:
Work el
Work Fax:
Work addr: ¥
E-mnail: ||
Mabile tel: r
Details | Nu:utes+ The Notes tab is a good place
123| 1|2|3 |4 |5 |ﬁ |—._, |B|'EI|I]|- =|* for maps and directions.
Tahlg|wle[r[t[y|uifo[p|[[]
caPla[s[d[fla[h[ilk[I1];]"]
shift z[x[c[v[b[n[m[,[.[/]+
cufain] - [\] [L[t]<]~

Edit @j

2. Using the Input panel, enter a name and other contact information. You will need to
scroll down to see all available fields.

3. To assign the contact to a category, scroll to and tap Categories and select a
category from the list. In the contact list, you can display contacts by category.

Contacts Tx 4% 1:46 @

[]Business
[ ]Personal

Select | add/Delete |
Edit E|a~

4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see “Notes: Capturing Thoughts and Ideas,”
later in this chapter.

5. Tap OK to return to the contact list.

User’s Manual | 8-8



Using the Summary Screen

When you tap a contact in the contact list, a summary screen is displayed.

Contacts Tx =% 2:01 @
Sw Kim

Manager

Technical Writing

02-3423-0000 Wark kel

Seocho-gu, Seocho-dong,  Work addr
Seoul, South Korea 137-

255

anager@Communicate,, E-rnail

bbb f e, b c0 ey web page

0Z2-577-0000 Home el

Surnrnaty | Nu:ltes,! Tap to view notes.
Edit Tools |-

Tap to change contact
information.
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Tasks : Keeping a To-Do List
Use Tasks to keep track of what you have to do.

Select the category of tasks you want displayed in the list.

all Tasks & Priokity L Select the sort order of the list.

Indicates high priority. "] planning Web site of our corporat® Tap to display or edit the task details.
[l ¢ writing manual

Tap and hold to display a pop-up menu
of actions.

Create Copy
Delete Task

Beam Task...

He#u Tools E|*
|

Tap to create a new task.

To change the way information is displayed in the list, tap Tools, and then tap Options.

To create a task

1. Tap New.

Tap to return to the task list (the task is
saved automatically).

Ty 4% 2:13 @

Subiject:
Priority: Mot mal
Status: Mot Completed
Skarks: Mone

Due: MNone
Qccurs: DNCE

Tap to choose from predefined subjects.

Reminder: More

Cateqories: MO Categories...
Task | Motes Notes is a good place for maps
1231[2][3[4]5]6]7]B[0]0]-[=[®] 2nddrawinas.
Tabjg[wle|[r|t[y[u]i|o]p
CaPlafs[d[ffa[h]ifk[I[:]"]
shift| z[x[c[v[b[nm[,[.[/]+
ctfaia] - [\ ] [V]t]e]~>

Edit |@ Tap to hide Input Panel.

—

.
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Using the Input panel, enter a description.

3. You can enter a start date and due date or enter other information by first tapping
the field. If the Input panel is open, you will need to hide it to see all available fields.

4. To assign the task to a category, tap Categories and select a category from the list.
In the task list, you can display tasks by category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For
more information on creating notes, see “Notes: Capturing Thoughts and Ideas,”
later in this chapter.

6. Tap OK to return to the task list.

To quickly create a task with only a subject, tap Entry Bar on the Tools menu, and then
tap Tap here to add a new task.

Using the Summary Screen

When you tap a task in the task list, a summary screen is displayed. To change the task,
tap Edit.

Ty % 2:14 @
writing manual Yo View task details.
¥ Tap to show and hide additional summary
chinese version information.
® View notes.
Edit Tools E|a~
[

Tap to change task.
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Notes : Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes.
You can create a written note or a recording. You can also include a recording in a note.
If a note is open when you create the recording, it will be included in the note as an icon.
If the note list is displayed, it will be created as a stand-alone recording.

Tx % 2:32 9

Mame # — Tap to change the sort order of the list.

Create Copy - Tap and hold to display a pop-up
menu of actions.

Delete

Select all

Send via E-miail...

Beam File...
Rename,;/Move...
Tap to show or hide the Recording
\ toolbar.
[
NEW Tools E|‘

Tap to create a new item.

To create a note

1. Tap New.

Motes T =2 2:35 @

r

(@ [m]» [(—— [ ]t
Mew Edit Tools |E||é| E|*
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2. Create your note by writing, drawing, typing, or recording.

Y

] These icon display the voice recording.

_——
1l

L] l-l‘-’ [ Um
“" ( \ ‘l\)@ﬁo Display the process of recording.

Recordbutton—t. | [ | 4 | [——= |H1 L |'='ﬂ‘ﬂ'
Mew Edit Tools & E|‘

Tap to show or hide the — — Pen button
Recording toolbar.

Create your note by writing, drawing, typing, or recording. For more information about
using the Input panel, writing and drawing on the screen, and creating recordings, see
“Entering Information Using the Input Panel” in chapter 3.
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Chapter 9
Microsoft Programs

Your device includes Microsoft Pocket PC Software 2002(Microsoft Pocket Word,
Microsoft Pocket Excel, Windows Media Player for Pocket PC, Microsoft Reader, and
Microsoft Messenger). This section provides an overview of these programs and enough
information to get you started. For complete instructions on using a program, refer to
online Help for that program.

@ In this chapter, you will learn about
— Microsoft Pocket Word

— Microsoft Pocket Excel

— Microsoft Windows Media Player

— Microsoft Reader

— Microsoft Messenger

Chapter 9 Microsoft Programs | 9-1



Microsoft Pocket Word

Microsoft Pocket Word works with Microsoft Word on your desktop PC to give you easy
access to copies of your documents. You can create new documents on your device, or
you can copy documents from your desktop PC. Synchronize documents between your
desktop PC and your device regularly so that you have the most up-to-date content in
both locations.

To use Pocket Word

1. On the Start menu, tap Programs, and then tap the Pocket Word icon.

Pocket Word T % 4:27 @

123(1][2[3]4[s5[6[7[8[9]0]- =]«
Tabla[wle|r[t[y[ulifo[p|[
CAPla[s[d[f[alh[jlk[1]:["]
shift] z[2 [c[v[b[n[m[. [. [ /] +
ctfai] * [\] [ [t]e]-
NF?W Edit Yiew Tools *0—% Tap to show and hide toolbar.

|

Tap to make a new word file.

—

.

2. Tap New to open a blank document.

You can open only one document at a time; when you open a second document, you will
be asked to save the first. You can save a document you create or edit in a variety of
formats, including Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

You can enter information in Pocket Word in four modes: typing, writing, drawing, and
recording. Use the View menu to switch between modes. Each mode has its own toolbar,
which you can show and hide by tapping the Show/Hide Toolbar button on the
Command bar.

Typing Mode. Use the Input panel to enter typed text into the document with either the
keyboard or the Letter Recognizer.

For more information on entering typed text, see “Entering Information” in chapter 3.
Writing Mode. In writing mode, use your stylus to write directly on the screen. Ruled
lines are displayed as a guide, and the zoom magnification is greater than in typing
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mode to allow you to write more easily. For more information on writing and selecting
writing, see “Entering Information” in chapter 3.

Written words are converted to graphics (metafiles) when a Pocket Word document is
converted to a Word document on your desktop PC.

Drawing mode. In drawing mode, use your stylus to draw on the screen. Gridlines
appear as a guide. When you lift your stylus off the screen after the first stroke, you will
see a drawing box indicating the boundaries of the drawing. Every subsequent stroke
within or touching the drawing box becomes part of the drawing. For more information on
drawing and selecting drawings, see “Entering Information” in chapter3.

Recording mode. Use recording mode to embed a recording into your document.
Recordings are saved as WAV files. For more information on recording, see “Entering
Information” in chapter3.

To open a template rather than a blank document, select a template for new documents.
On the Tools menu, tap Options, and then browse to select the default template. When
you tap New, the template appears with appropriate text and formatting already provided.

Tx £ 4:37 @

Options

Default kemplake:

Save ko

|Mair‘| Moy v|

Display in list wigw:

|Kn|:|wr‘| types v|

E|‘

Tips for Working in Pocket Word

B You can change the zoom magnification by tapping View and then Zoom. Then
select the percentage you want. Select a higher percentage to enter text and a lower
one to see more of your document.

® [f you are opening a Word document created on a desktop PC, select Wrap to
Window on the View menu so that you can see the entire document.
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Microsoft Pocket Excel

Microsoft Pocket Excel works with Microsoft Excel on your desktop PC to give you easy
access to copies of your workbooks. You can create new workbooks on your device, or
you can copy workbooks from your desktop PC to your device. Synchronize workbooks
between your desktop PC and your device so that you have the most up-to-date content
in both locations. Pocket Excel provides fundamental spreadsheet tools, such as
formulas, functions, sorting, and filtering, which enable you to create simple workbooks,
such as expense reports and mileage logs.

To use Pocket Excel

1. On the Start menu, tap Programs, and then tap the Pocket Excel icon.

.f:.j' Pocket Excel Tx £ 441 @

Al
A B | ¢ ||
1 o
_2 | =
_3 | -
_4 | —
_3 |
_6 | Tap to select a sheet.
? -
A 0] Il
Feady |5hEEt1“V ||5U|TI=|:| o Tap to select a function you want.
1231][2[3]4[s[6[7[8][a]0]-][=[e«
Tabjg|wle[r[t[y|ufifo[p[[]]
CaPla[sd[flalh][ifk[I]:]"]
shift] z[2[c[v[b[n[m[.[. [f] +
ctaii] -~ [\ ] [ [t]e]~

New Edit ¥iew Format Tools TO—@ji Tap to show and hide toolbar.

Tap to make a new Excel file.

2. Tap New to open a blank workbook.

To open a template rather than a blank workbook, select a template for new workbooks.
On the Tools menu, tap Options, and then browse to select the default template. When
you tap New, the template appears with appropriate text and formatting already provided.
You can open only one workbook at a time; when you open a second workbook, you will be
asked to save the first. You can save a workbook you create or edit in a variety of formats,
including Pocket Excel (.pxl) and Excel (.xIs).
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Tips for Working in Pocket Excel

View in full-screen mode to see as much of your worksheet as possible. Tap View
and then tap Full Screen.

If your workbook contains sensitive information, you can protect it with a password.
To do so, open the workbook, tap Edit, and then tap Password.

Freeze panes on a worksheet. First, select the cell where you want to freeze panes.
Tap View and then tap Freeze Panes. You might want to freeze the top and leftmost
panes in a worksheet to keep row and column labels visible as you scroll through a
sheet.

Split panes to view different areas of a large worksheet. Tap View and then tap Split.
Then drag the split bar to where you want it. To remove the split, tap View and then
tap Remove Split.

Show and hide rows and columns. To hide a row or column, select a cell in the row
or column you want to hide. Tap Format, then tap Row or Column, and then tap
Hide. To show a hidden row or column, tap Tools, then tap Go To, and then type a
reference that is in the hidden row or column. Tap Format, then tap Row or Column,
and then tap Unhide.
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Microsoft Windows Media Player

Use Microsoft Windows Media Player for Pocket PC to listen to digital audio and video
files, such as songs or movie clips. Media Player supports sound files recorded in MP3,
WMA, WMV, ASF, WMP formats.

To start Windows Media Player

On the Start menu, tap Programs, and then tap the Windows Media Player icon.

*fwj windows Media Tae o2 4:48 6

‘t Corp, - 51 kbps

'y
Windows
Media Player

Indicates the progress of the
current track.

Tap to play or
pause.

Tap to selectasong _ Galect T Tap to adjust volume.
or make a playlist. ‘

Tap to stop. Tap to skip to the next song.

Tap to play a previous song.

To play the music file repeatedly, select Repeat on the Tools menu.
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To set the options of Audio & Video, select Settings on the Tools menu and then select
Audio & Video.

l.%.}" Windows Media Tx £ 4:53 @

Audio

While using another program:

Video
Play videno in Full screen:

|Never - Tap to set the size of screen when
playing back a video file.

|:| Shirirk, ta Fit in window
[ ] Rotate 180 degrees in full screen

E|‘

To set the options on buttons of Windows Media Player, select Settings on the Tools

menu and then select Buttons.

Windows Media Tx ™% 4:58 @

1. Select Function

ZPreview =

Play | Pause
Play
Pause

Skop

Mexk Track
Previous Track,
Mute

|:| IUn-rap buttons during background play,

E|‘
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To select a song and a playlist, tap Select.

.f:;' Windows Media Tx #% 5:02 @

Select Playlist == Tap to select a folder
[ Local Content

[_1'¥eb Favorites

(I Organize Playlists

‘ Tap to delete the selected item.
$FRXev O b i [

(] ( ] ( ]

e

Tap to add the Tap to move the selected file
selected file to upward and downward.
a playlist.

Your device is uniquely identified by a UUID (Universally Unique ID). Many publishers of
digitally secured content, such as MP3 music files and electronic books (eBooks) use
digital rights management that relies on the device’s UUID to prevent unauthorized
usage. After your device has been serviced or repaired, you may be unable to access

digitally secured content that you had downloaded prior to the service. In such cases,
contact the content publisher for assistance.

Working with Audio Files on a SD Card

Because songs and audio files can use a lot of storage memory, you might want to store
them on a SD memory card.
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Microsoft Reader

Use Microsoft Reader to read eBooks(extension name : *.lit) on your device. Download
books to your desktop PC from eBook Web sites. Then, use ActiveSync to copy the book
files to your device. The books appear in the Reader Library.

To start Microsoft Reader

On the Start menu, tap Programs, and then tap Microsoft Reader.

l.%.}" Microsoft Reader %, #{£ 1:45 °

Microsoft® Reader Help
Vondsy, April 22, 200z

=T}
Vondsy, April 22, 200z

Pocket PC July, 2007

Packet PC _Iulj,,r, =001 Pop-_up menu that results from
. tapping and hold.
Delete

Most recent page
About this title

Tap to go back to the Library.

Each book consists of a cover page, an optional table of contents, and the pages of the
book. You can

m Page through the book by using the up/down control on your device or by tapping the
page number on each page.

B Annotate the book with highlighting, bookmarks, notes, and drawings.

B Search for text and look up definitions for words.

The Reader Guidebook is preinstalled on your device, and contains all the information
you will need to use Microsoft Reader. To open the Guidebook, tap Help on the Reader
command bar. Or, on a book page, tap and hold on the book title, and then tap Help on
the pop-up menu.
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Getting eBooks for Your device

You can download book files from the Web. Just visit your favorite eBook retailer and
follow the instructions to download the book files. Sample books and a dictionary are
also included in the MSReader folder in the Extras folder on the Pocket PC Companion
CD.

Your device is uniquely identified by a UUID (Universally Unique ID). Many publishers of
digitally secured content, such as MP3 music files and eBooks, use digital rights
management that relies on the device's UUID to prevent unauthorized usage. After your
device has been serviced or repaired, you may be unable to access digitally secured
content that you had downloaded prior to the service. In such cases, contact the content
publisher for assistance.

Using the Library

The Library is your Reader home page; it displays a list of all books stored on your
device or storage card.

Reading a Book

Each book consists of a cover page, an optional table of contents, and the pages of the
book. Navigation options are listed in the bottom portion of the cover page.

The first time you open a book, you will probably want to go to the first page or to the
table of contents, if there is one. Subsequently, whenever you open the book, you will be
automatically taken to the last page you read.

In addition to the text, each book page includes a page number and book title.

Microsoft Reader %, #{£ 1:46 °

« PoOcket PC July, zoo1 e Tap to open pop-up menu.
Cover Page

Tahle of Cantents [PC

Annotations e, con-

Help itiful,

Library d be a

settings Jram

Return e Tap to go back to the Library.

needed Tuﬁcticm, or
a piece of hardware
that turns your

Tap arrows to turn the page, or tap and
4 4 pe hold page number to bring up page riffle.
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#3 Microsoft Reader 45 2:02 0

w PoOcket PC July, zoo

or Handheld PC
more effective, con-
venient, beautiful,
or fun. It could be a
software program
that adds some
heeded function, or
a piece of hardware

Tap here to turn much

that turns FDUF‘ more pages with one tap.
Mg o B % Tapto return to the
; | original state.

Tap here to navigate to other parts of the Reader.

You can also page through a book by using the up/down control on your device.

Using Reader Features

Reading a book electronically gives you several options not available with paper books.

These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-up

menu, as described here:

B Search for text. Find text in a book by tapping Find on the popup menu. Enter the
word you want to search for, and tap the desired Find option. Reader highlights the
found text on the page. To close Find, tap outside the box. To return to your original
page, tap the title and then tap Return on the pop-up menu.

B Copy text. You can copy text from books that support this feature into any program
that accepts text. On a book page, select the text you want to copy, and then tap
Copy Text on the pop-up menu. The text can be pasted into the program of your
choice.

B Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon
appears in the right margin. You can add multiple bookmarks to a book. Then, from
anywhere in the book, tap the bookmark icon to go to the bookmarked page.

B Highlights. When you highlight text, it appears with a colored background.

B Notes. When you attach a note to text, you enter the text in a notepad that appears
on top of the book page. A Note icon will be displayed in the left margin. To show or
hide the note, tap the icon.

B Drawings. When you add a drawing, a Drawing icon appears in the lower-left corner
of the page, and drawing tools appear across the bottom of the page. Draw by
dragging your stylus.
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Text

Highligh

B Annotations. To see a list of a book’s annotations, including bookmarks, highlights,
text notes, and drawings, tap Annotations Index on the book’s cover page. You can
tap an entry in the list to go to the annotated page.

f:}' Microsoft Reader % 4 2:33

w POcket PC July, zoon L
and the Programs
menu of Handheld
PCs. You can use
‘8 the arrow keys on
ah H/PC to move
o Nerdly around the
maze, or the stylus
oh a Pocket or
Palm-size PC. The

M4 44 B3g ke bH X

o (AR 1869

Removing a Book

Drawing icon

Bookmark

Drawing

When you finish reading a book, you can delete it to conserve space on your device. If a
copy of the book is stored on your desktop PC, you can download it again at any time.
To remove a book from your device, tap and hold the title in the Library list, and then tap

Delete on the pop-up menu.
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MSN Messenger

MSN Messenger is an instant messaging program that lets you see who is online, send
and receive instant messages and have instant message conversations with groups of
contacts.

To use MSN Messenger, you must have a Microsoft Passport account. If you have a
Hotmail® or MSN account, you already have a Passport. Once you have obtained a
Microsoft Passport, you are ready to set up your account.

Sign up for a Microsoft Passport account at http://www.passport.com . Get a free
Microsoft Hotmail e-mail address at http://www.hotmail.com.

To set up an account and sign in

1. On the Start menu, tap Programs, and then tap the MSN Messenger icon.
2. Onthe Tools menu, tap Options. On the Accounts tab, enter your Passport

account information.

Iy display name

Rlarme: | o—li Enter your name for chat.

Conneckion

Fun this program upon connection

General | Privacy | Accounks |

E|A

Accounts

E E

[w]eEnable Passport account Select Passport account.
Signin name: |5y kimesther@hotrmal.c
Password: |

—— Enter your name and password.

[ ] Enable Exchange account

Sign in name: | |

Passwiord: | |

Sign in using this account first
@ Passport account
{0} Exchange account

General | Privacy | Accounts

E|“

Chapter 9 Microsoft Programs | 9-13



3. Tap OK.

4. Tosign in, tap the sign-in screen and enter your e-mail address and password.

Tap here to sign in \\"ﬂ-*-"“'*"“

msn*.

Messenger Service

MSN Messenger ofZ 11:24 6 MSMN Messenger ofZ 11:22

Signin name:
|*********@hutmail.cum |
Examples: name_123@hokmail . com

Y NAmE@rnsn . conm

example@passport, com
Password;
| dkckck sk kek |

Save password

| Cancel || Sign in I

123)1[2]3]4]|s5]6|7][8][a0]-[=]w

Tab[g[wle[r [ty uli]o]p

[
caPla[s[d[f]a[n]i[k[1[:]"

!

shirt| z [x[c[v[b][n[m[,[.[7]
ctlaia] " [\] [4[t]e]=

Tools Chakts E|*

o

Tap here to register.

The account you entered before displays.

If you already use MSN Messenger on your desktop PC, your contacts will show
up on your device without being added again.

Working with Contacts

The MSN Messenger window shows all of your messenger contacts at a glance, divided
into Online and Not Online categories. From this view, while connected, you can chat,

send e-mail messages, block the contact from chatting with you, or delete contacts from

your list using the pop-up menu.

(3| MM Messenger A TR
..i. linee-{oRliRe)
..i. Online

To make a new name for chat, tap
Options on the Tools menu.

Send an Instant Message
Send Mail (toflowers12@hotmail....
Block °

Delete Contack

Properties

Tools Chats E|‘

Tap a contact to start a chat.

Tap and hold to display a pop-up menu of
actions.
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To see others online without being seen, on the Tools menu, tap My Status, and
then tap Appear Offline.

@ O

If you block a contact, you will appear offline but will remain on the blocked
contact’s list. To unblock a contact, tap and hold the contact, then tap Unblock
on the pop-up menu.

Chatting with Contacts

Tap a contact name to open a chat window.

(53 | MM Messenger & ot a5e (D

Wou are chatting with: kkk

kkk says:
® The message you enter
display here.

° JSend|  Textentry area
123/1|2]|3[4|5]6|7]|g[0|0]-[=[«
Tabja|wle[r|t[y[u|i[o[p
cAPlals[d[flalh[j[k[I];]"]

Shift| | [/]+
Lt]el-

Taols Chats My Text i"—j@ﬁ —— Contacts icon

Enter your message in the text entry area at the bottom of the screen (or tap My Text to
enter a preset message), and then tap Send. To invite another contact to a multi-user
chat, on the Tools menu, tap Invite, and then tap the contact you want to invite.

To switch back to the main window without closing a chat, tap the Contacts
button. To revert to your chat window, tap Chats, and then select the person with
whom you were chatting.
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Adding a Contact

To add a new contact, tap Add a Contact on the Tools menu.

.f:.j' M3M Messenger o 5:04 6

Add a Contack

Sigr-in Marne:

Examples: name_123@hokmail, com
myname@msn, Conm
examplei@passport. com

| Zancel || Mlexk |

123(1[2]|3[4|s5]6|7][g[o|0]-[=]w
Tabja[wle[r[t[y[ulilo[p|[
CaPla[s[d[flalhn]jlk[1]:["]
shift| z [ [c[v][b[n[m[,[.[/] «
ctlaii] * [\ ] [Vt ]e]~>

|
[ 1

E|‘

Editing My Text Messages

Tap Edit My Text Messages on the Tools menu to enter a preset message.

3 M5k Messenger & d¢s0 D

My Text Messages

Tap a message, then edit below,

Mo, .
I can't talk right fowe.
I'l be right there,

I'm runnitg late, —
Where are you?
Hi.

1]

Yes,

Select a message among the list

that is preset.

User’s Manual

9-16



Chapter 10
Support & Service

Web site

You can obtain product information as well as tips and hints on how to get more from the
product at our Web site. This computer service is provided free of charge; you pay only
for telephone charges and Internet service fees. To connect to this Web site from a
computer via the Internet, go to www.cb.co.kr.

Service

For diagnostic instructions and other service information, contact one of the technical
support numbers. Please do not ship your device for service without first contacting a
CYBERBANK office. If your device qualifies for in-warranty service, be ready to supply a
dated proof of purchase.

Before you contact us for help, be sure to:

1.  Review the manuals whenever possible.

2. Have the following information about the product:

® model number

® serial number

B purchase date

3. Have your product ready to use. The support personnel may ask you to run tests
and other operations.

4. Organize your question or problem. The more detailed information you can provide,
the quicker the support personnel can help you.
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Appendix A I

Hardware Specifications

Items Descriptions

OS Pocket PC 2002

PDA PXA250 —200MHz (Cotulla)
Processor MSM5000

CDMA (Temperature : -20~60C,

Humidity : 0 ~ 95%)

Phone Module

CDMA2000 1XRTT

Memory ROM Flash Memory(64Mbyte)
RAM SDRAM(64Mbyte)
Main Li-Polymer 1400mAh
Li-lon 3.7V, 110mAh,
Battery Backup Time for charging : 6 hours
Charge by Main battery or the external
power
Size (mm)
width x length x height 70.5x129.5x 18
Weight (g) 1999
Screen Resolutions 240 X 320
Color 3.5 " Reflective, TFT LCD 65K Color

External Power

110~220V(charging : 800mAh)

DC 5V, 2A
Charging the main and backup battery
at the same time

Cradle Time for charging the backup battery :
max 3.5 hours
Operating Temperature : -20~60C
Operating Humidity : 0 ~ 95%
USB . .
o (Universal Serial Bus) Client(charging : 450mA)
Connector L - External memory card
(Secure Digital)
IrDA 115Kbps
For Stand-by 80~200 hours
Time For voice communications 2.5 hours (PDA Sleep mode)
For PDA 12 hours(Phone stand-by mode)
LED Battery charging status (Red, Blue)
Phone Status (Red, Green, Blue)
Sound Stereo while using headset
For voice communications
Speaker
For PDA alarm
Vibrator Muting instead of phone ring
Microphone For voice communications & recording

Interface Connecter

USB Client, Power, DM Port, Serial
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Appendix B I

Warranty

Important: This is your hardware product warranty statement. Read it carefully. Warranty
terms may be different in your country. If so, your authorized dealer or sales and service

office can give you details.

One year limited hardware warranty

CYBERBANK warrants this hardware product against defects in material and
workmanship for a period of one year from receipt by the original end-user purchaser. If
CYBERBANK receives notice of the above-defined defects during the warranty period,
CYBERBANK will either, at its option, repair or replace products that prove to be
defective. Should CYBERBANK be unable to repair or replace the product within a
reasonable amount of time, the customer's alternate exclusive remedy shall be a refund
of the purchase price upon return of the product.

Limitation of warranty

The above warranty shall not apply to defects resulting from: misuse;

unauthorized modification; opening for any reason; operation or storage outside the
environmental specifications for the product; in-transit damage;

improper maintenance; or defect resulting from use of non-CYBERBANK software,
accessories, media, supplies, consumables, or such items not designed for use with the
product.

CYBERBANK makes no other express warranty, whether written or oral, with respect to
this product.

Any implied warranty of merchantability or fitness for a particular purpose is limited to the
one-year duration of this written warranty.

Some states, provinces, or countries do not allow limitations on how long an implied
warranty lasts, so the above limitation or exclusion may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights that
vary from state to state, province to province, or country to country.

Appendix B Warranty | B-1



CYBERBANK Software Product License Agreement and
CYBERBANK Software Product Limited Warranty

This CYBERBANK product contains preinstalled software programs. Please read the
CYBERBANK Software Product License Agreement before proceeding.

Important: Carefully read this License Agreement and the Limited Warranty statement
before operating the equipment. The rights to the software are licensed, not sold.
CYBERBANK or its licensors continue to own all intellectual property rights to the
software, and you will be granted certain rights to use the software upon your
acceptance of this license. Rights in the software are offered only on the condition that
you agree to all terms and conditions of the License Agreement. Operating the
equipment indicates your acceptance of these terms and conditions. If you do not agree
to the terms and conditions of the License Agreement, return the complete package for a
full refund now.

CYBERBANK Software Product License Agreement

The CYBERBANK Software Product License Agreement shall govern the use of all
software that is provided to you, the customer, as part of this CYBERBANK product with
the exception of Microsoft Software. Microsoft Products are licensed to you under the
Microsoft End User License Agreement (EULA) contained in the Microsoft
documentation. Any third-party software supplier's warranty terms that may be found
online, or in any documentation or other materials contained in the product packaging,
shall govern the use of that third-party software.

Use

You may only use the software on a single computer. You may not reverse, assemble, or
decompile the software.

Copies and adaptations

You may make copies or adaptations of the software (a) for archival purposes, or (b)
when copying or adaptation is an essential step in the use of the software with a
computer so long as the copies and adaptations are used in no other manner.

You have no other rights to copy unless you acquire an appropriate license to reproduce
which is available from CYBERBANK for some software.

You agree that CYBERBANK provides no warranty, free installation, or free training for
any copies or adaptations made by you.

All copies and adaptations of the software must bear the copyright notice(s) contained in
or on the original.
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Ownership

You agree that you do not have any title to or ownership of the software, other than
ownership of the physical media. You acknowledge and agree that the software is
copyrighted and protected under the copyright laws.

You acknowledge and agree that the software or part thereof may have been developed
by a third-party software supplier named in the copyright notice(s) included with the
software, who shall be authorized to hold you responsible for any copyright infringement
or violation of this or their own License Agreement.

Transfer of rights in software

You may transfer rights to the software to a third party only as part of the transfer of all your
rights and only if you obtain the prior agreement of the third party to be bound by the terms of
this License Agreement. Upon such a transfer, you agree that your rights to the software are
terminated and that you will either destroy all your copies and adaptations or deliver them to
the third party. Transfer to a U.S. government department or agency or to a prime or lower
tier contractor in connection with a U.S. government contract shall be made only upon prior

written agreement to terms required by CYBERBANK.

Sublicensing and distribution

You may not lease, sublicense the software, or distribute copies or adaptations of the
software to the public in physical media, by telecommunication or at all without the prior
written consent of CYBERBANK.

Termination

CYBERBANK may terminate this software license for failure to comply with any of these
terms, provided CYBERBANK has requested you to cure the failure and you have failed to do
so within thirty (30) days of such notice.

Updates and upgrades

You agree that the software does not include updates and upgrades that may be available
from CYBERBANK under a separate support agreement.
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